# LIST OF CONTENTS

**OVERVIEW** .................................................................................................................. 7

**GETTING STARTED** ........................................................................................................ 13

**SIGN CONVENTION** ........................................................................................................ 17

**WORKSPACE** .................................................................................................................. 21

4. **OVERVIEW** ................................................................................................................. 23

4.1 **THE MAIN PROGRAM WINDOW** .............................................................................. 23

4.1.1 Main Program Window Menu Items and Corresponding Tools ......................... 24

4.1.1.1 File Menu ........................................................................................................ 24

4.1.1.2 Action Menu .................................................................................................... 25

4.1.1.3 View Menu ....................................................................................................... 25

4.1.1.4 Options Menu .................................................................................................. 26

4.1.1.5 Window Menu .................................................................................................. 26

4.1.1.6 Help Menu ....................................................................................................... 27

4.2 **ADAPT-PT INPUT SCREEN** ...................................................................................... 27

4.2.1 ADAPT PT-Input Menu Items and Tools .................................................. 29

4.2.1.1 File ................................................................................................................ 30

4.2.1.2 Project ............................................................................................................. 30

4.2.1.3 Geometry .......................................................................................................... 30

4.2.1.4 Loads ................................................................................................................ 30

4.2.1.5 Material ............................................................................................................ 30

4.2.1.6 Criteria ............................................................................................................. 30

4.2.1.7 Execute ............................................................................................................. 31

4.2.1.8 Tools ................................................................................................................. 31

4.2.1.9 Window ............................................................................................................. 31

4.2.1.10 Structure View ............................................................................................... 31

4.2.1.11 View Tools Toolbar ...................................................................................... 31

**BASIC PROGRAM OPERATIONS** .................................................................................. 35

5. **OVERVIEW** ................................................................................................................. 37

5.1 **START A NEW PROJECT** .................................................................................... 37

5.2 **OPEN AN EXISTING PROJECT** ......................................................................... 37

5.3 **SAVE INPUT DATA** ............................................................................................ 37

5.4 **SAVE INPUT DATA AS DEFAULT** ..................................................................... 38

5.5 **SELECT SYSTEM OF UNITS** ............................................................................. 38

5.6 **CONVERT SYSTEM OF UNITS** ......................................................................... 39

**STRUCTURAL MODELING** ......................................................................................... 41

6 **OVERVIEW** ................................................................................................................ 43
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>PROJECT INFORMATION</td>
<td>43</td>
</tr>
<tr>
<td>6.1.1</td>
<td>Specify General Project Information</td>
<td>43</td>
</tr>
<tr>
<td>6.1.2</td>
<td>Specify Analysis and Design Options</td>
<td>44</td>
</tr>
<tr>
<td>6.2</td>
<td>GEOMETRY</td>
<td>48</td>
</tr>
<tr>
<td>6.2.1</td>
<td>Specify Span Geometry</td>
<td>48</td>
</tr>
<tr>
<td>6.2.1.1</td>
<td>Prismatic (Uniform) Spans</td>
<td>49</td>
</tr>
<tr>
<td>6.2.1.2</td>
<td>Non-prismatic (non-uniform) spans</td>
<td>53</td>
</tr>
<tr>
<td>6.2.2</td>
<td>Specify Effective Flange Width</td>
<td>56</td>
</tr>
<tr>
<td>6.2.3</td>
<td>Specify Geometry of Drop Cap and/or Transverse Beam</td>
<td>57</td>
</tr>
<tr>
<td>6.2.4</td>
<td>Specify Geometry of a Drop Panel</td>
<td>58</td>
</tr>
<tr>
<td>6.2.5</td>
<td>Specify Support Geometry and Stiffness</td>
<td>58</td>
</tr>
<tr>
<td>6.2.6</td>
<td>Specify Support Boundary Conditions</td>
<td>60</td>
</tr>
<tr>
<td>6.3</td>
<td>LOADS</td>
<td>62</td>
</tr>
<tr>
<td>6.3.1</td>
<td>Specify Dead, Live and Other loads</td>
<td>62</td>
</tr>
<tr>
<td>6.3.2</td>
<td>Specify Lateral Loads</td>
<td>64</td>
</tr>
<tr>
<td>6.4</td>
<td>MATERIAL</td>
<td>64</td>
</tr>
<tr>
<td>6.4.1</td>
<td>Specify Concrete Material</td>
<td>64</td>
</tr>
<tr>
<td>6.4.2</td>
<td>Specify Reinforcement Material</td>
<td>65</td>
</tr>
<tr>
<td>6.4.3</td>
<td>Specify Post-Tensioning Material</td>
<td>66</td>
</tr>
<tr>
<td>6.5</td>
<td>CRITERIA</td>
<td>66</td>
</tr>
<tr>
<td>6.5.1</td>
<td>Specify the Design Code</td>
<td>67</td>
</tr>
<tr>
<td>6.5.2</td>
<td>Specify Base Non-Prestressed Reinforcement</td>
<td>67</td>
</tr>
<tr>
<td>6.5.3</td>
<td>Specify Allowable Stresses</td>
<td>69</td>
</tr>
<tr>
<td>6.5.4</td>
<td>Specify Recommended Post-Tensioning Values</td>
<td>70</td>
</tr>
<tr>
<td>6.5.5</td>
<td>Specify Calculation Options</td>
<td>70</td>
</tr>
<tr>
<td>6.5.6</td>
<td>Specify Tendon Profile</td>
<td>71</td>
</tr>
<tr>
<td>6.5.7</td>
<td>Specify Minimum Covers</td>
<td>72</td>
</tr>
<tr>
<td>6.5.8</td>
<td>Specify Minimum Bar Length</td>
<td>73</td>
</tr>
<tr>
<td>6.5.9</td>
<td>Specify Load Combinations</td>
<td>74</td>
</tr>
<tr>
<td>7</td>
<td>PROGRAM EXECUTION</td>
<td>77</td>
</tr>
<tr>
<td>7.1</td>
<td>OVERVIEW</td>
<td>79</td>
</tr>
<tr>
<td>7.2</td>
<td>PT RECYCLING WINDOW TABS</td>
<td>80</td>
</tr>
<tr>
<td>7.3</td>
<td>DESIGN INDICATOR BOX</td>
<td>85</td>
</tr>
<tr>
<td>7.4</td>
<td>RECYCLE WINDOW CONTROL BUTTONS</td>
<td>87</td>
</tr>
<tr>
<td>7.4.1</td>
<td>PT SELECTION METHOD</td>
<td>89</td>
</tr>
<tr>
<td>7.4.2</td>
<td>Force Selection Method</td>
<td>89</td>
</tr>
<tr>
<td>7.4.2.1</td>
<td>Description of Features</td>
<td>90</td>
</tr>
<tr>
<td>7.4.2.2</td>
<td>Description of Execution</td>
<td>92</td>
</tr>
<tr>
<td>7.4.2</td>
<td>Tendon Selection Method</td>
<td>89</td>
</tr>
</tbody>
</table>
## OVERVIEW

### 8.1 ADAPT-PT SUM SCREEN

**8.1.1 ADAPT-PT Sum Menu Items and Corresponding Tools**

- **8.1.1.1 File menu**
- **8.1.1.2 Graphs menu**
- **8.1.1.3 Options menu**
- **8.1.1.4 Window menu**
- **8.1.1.5 Help menu**
- **8.1.1.6 Summary Report**

## REPORTS

### 9 OVERVIEW

**9.1 REPORT GENERATOR SCREEN**

**9.2 HOW TO CREATE REPORT**

**9.3 DESCRIPTION OF REPORT SECTIONS**

- **9.3.1 Report Cover Page**
- **9.3.2 Table of Contents**
- **9.3.3 Concise Report**
- **9.3.4 Compact Report**
  - **9.3.4.1 Section 1: User Specified General Analysis and Design Parameters**
  - **9.3.4.2 Section 2: Input Geometry**
  - **9.3.4.3 Section 3: Input Applied Loading**
  - **9.3.4.4 Section 4: Calculated Section Properties**
  - **9.3.4.5 Section 5: Moments, Shears and Reactions**
  - **9.3.4.6 Section 6: Moments Reduced to Face of Support**
  - **9.3.4.7 Section 7: Selected Post-tensioning Forces and Tendon Profiles**
  - **9.3.4.8 Section 8: Factored Moments and Reactions Envelope**
  - **9.3.4.9 Section 9: Factored Lateral Moments Envelope**
  - **9.3.4.10 Section 10: Mild Steel - No Redistribution**
  - **9.3.4.11 Section 11: Mild Steel – Redistributed**
  - **9.3.4.12 Section 12: Shear Reinforcement**
  - **9.3.4.13 Section 13: Punching Shear Reinforcement**
  - **9.3.4.14 Section 14: Deflections**
  - **9.3.4.15 Section 15: Friction, Elongation and Long-Term Stresses**
- **9.3.5 Detailed Report**
  - **9.3.5.1 Section 21: Tendon Heights**
  - **9.3.5.2 Section 22: Post-tensioning Balanced Loading**
  - **9.3.5.3 Section 23: Detailed Moments**
  - **9.3.5.4 Section 24: Detailed Shears**
  - **9.3.5.5 Section 25: Factored Moments and Reactions**
  - **9.3.5.6 Section 26: Factored Lateral Moments**

## Footnotes

- [ADAPT](#)
9.3.5.7  Section 27: Detailed Stresses ....................................................162
9.3.5.8  Section 28: Required Post-tensioning .........................................162
9.3.5.9  Section 29: Detailed Rebar ..........................................................162
9.3.5.10 Section 30: Punching Shear Reinforcement ..................................163
9.3.5.11 Section 32: Unbalanced Moment Reinforcement .......................163
9.3.5.12 Section 34: Demand Moment and Moment Capacity ...............164

9.3.6  Graphical Report ............................................................................164
9.3.6.1  PT Force ..................................................................................164
9.3.6.2  PT-Profile ................................................................................165
9.3.6.3  Deflection ................................................................................165
9.3.6.4  Load Cases ................................................................................165
9.3.6.5  Load Combination .....................................................................167
Chapter 1

OVERVIEW
ADAPT-PT is the state-of-the-art industry standard computer program for the analysis and design of one-way or two-way post-tensioned floor systems and beams. It is based on a single story frame analysis with upper and lower columns. For two-way floor systems, the equivalent frame modeling of ACI can be used as an option. ADAPT-PT is a Windows-based program. ADAPT-PT treats multi-span continuous slab/plate and beam frames with or without cantilevers.

- In addition to drop caps, ADAPT-PT allows drop panels of different sizes to be specified for different supports. Having a general frame analysis module for variable sections, ADAPT-PT can accurately model a wide range of drop cap/panel geometries. Also, special modeling features implemented in the program facilitate the modeling of local thickening in the slab along the line of columns, generally referred to as slab bands.

- The slab/beam frame may be supported by walls, beams, or columns with different connection details such as clamped, rotational, free and more.

- ADAPT-PT fully incorporates the equivalent frame option as described in ACI-318 with no simplifications. In addition to the capability to handle the conventional configurations of column capitals and drop panels, the program allows the user to define a wide range of cross-sectional shapes. The software allows for the cross-section of the member to change along the length of a span, with abrupt steps, at the top, bottom, or both.

- Box girder bridge sections can be readily modeled as equivalent I-sections. ADAPT-PT is well suited for a first design of box girder bridges, where an initial estimate of the amount and location of prestressing is sought to achieve given stress levels and design criteria.

- For flanged beams, you can either select the software’s built-in effective width computation, based on ACI-318, or input a user-defined alternative effective width.

- The program recognizes and accounts for the difference between the effective width in bending and pure compression.

- Using the geometry of the structural model input by the user, the program calculates the selfweight loading of the structure for combination with other loads. The calculated values of the selfweight are reported in the program’s output.
• All the three systems of units—the American customary units (ft-lb), SI units (mm, Newton), and the MKS units (m, kg)—can be executed from the same copy of the software. Also, all the different codes are integrated into a single version.

• You can either edit the factory-set, or define your own default values for input of data, while retaining the option to revert to factory-set default values if you so choose.

• A library of tendon profiles allows the user to select a suitable tendon layout for each particular case. Common profiles included are the simple parabola, reversed parabola, simple parabola with straight portions over the supports, harped, strait and extended reversed parabola tendons. Low relaxation and stress-relieved strands, as well as unbonded and grouted post-tensioning systems, are also supported by ADAPT-PT.

• Uniform, line, partial, concentrated loads and moment, triangle, variable and trapezoidal loads may be specified in practically unlimited numbers and variations.

• ADAPT-PT accounts for the shift in the location of the neutral axis of a member at changes in cross-section along the member length. Thus, the program can correctly handle steps along a member.

• ADAPT-PT executes either automatically or interactively. In its automatic mode, based on user’s specifications, the software determines the required post-tensioning and the associated reinforcement. In its interactive mode, the program displays the calculated required post-tensioning on the screen to the user. You have the option to modify both the forces and the drapes during the program execution, and recycle the selection until a satisfactory design is obtained. Or, you can input the conditions of an existing design. You can select the actual number and position of strands along a member. Also, in the interactive mode, you can graphically view the distribution of stresses, tendon profile and the required post-tensioning. This provides a good guide for you to achieve an optimum design.

• Stresses are computed and reported using the actual forces and drapes selected. This feature distinguishes ADAPT-PT from simple programs, where a single-pass analysis is performed, in which the option of the user-initiated changes in post-tensioning are not reflected in the subsequent calculations. ADAPT-PT has a multi-pass processor. It updates all the design values based on changes made in the tendon profile and force before it concludes its report of design values.
• Serviceability design of the slab/beam is achieved through a detailed stress control followed by a deflection calculation. Where stresses exceed the cracking limits of concrete, a cracked section deflection estimate is carried out using an equivalent moment of inertia.

• A thorough strength analysis and design is conducted to determine any non-prestressed reinforcement that may be necessary to meet the ultimate strength limit conditions.

• Other code requirements for non-prestressed reinforcement, such as the minimum requirements of the building codes, are also checked and a listing of the reinforcement based on different criteria is reported.

• Bar sizes and lengths are selected and reported both in a graphical and tabulator format, ready to be entered on the structural drawings.

• The punching shear option checks the adequacy of the column caps as well as the immediate slab/drop panel region beyond the cap and provides punching shear reinforcements if required. For one-way slabs and beams, a one-way shear analysis is carried out. Shear reinforcement is calculated and the stirrup requirements are given.

• This version of ADAPT-PT can handle both the effective force and the variable force methods.

• In variable force method ADAPT-PT calculates the change of tendon force along its length and can use the force at each location along the length of a member to perform a code check for that location. In addition to the immediate losses due to friction, and seating loss, and at user’s option, the software accounts for the long-term stress losses along the length of the structure. Since long-term losses for grouted tendons are functions of local strain, an iterative non-linear capability is built into the program. The non-linearity in the solution is with increments of load.

• In the effective force mode, the force along each tendon is assumed constant. In this case, the design is based on a non-iterative linear solution in terms of the effective force.

• Another execution option is the computation only of immediate losses resulting from the friction and seating of strands. The long-term losses in prestressing are then effected through a user defined lump sum stress loss.
• The geometry of the structural model can be viewed on the screen in a three-dimensional space. The capability to rotate, pan, zoom and view the model allows the user to examine the structure in detail prior to the execution of the program. Errors in data entry or modeling are readily detected when user’s input is displayed on the computer screen. Hard copies of the graphical display of the structural model can be readily obtained.

• ADAPT-PT uses the detailed scheme throughout its operation. This scheme is based on 1/20th point values along each span. However, to retain the simplicity of presentation of the report, in addition to the optional 1/20th point reports, a summary of the solution is compiled for the left, center and right of each span.

• In addition to graphical reports, the outcome of the analysis and design is composed into a clear text file that can be viewed, edited and printed by you. The content and extent of the report can be controlled by you through a user-friendly menu.

• It is also possible to generate a one-page graphical summary report that extracts and incorporates all important design information in an easy-to-interpret format. The report may also be exported as a DXF file for incorporation into construction documents.

• The graphical display option of ADAPT-PT provides a vivid exposition of the distribution of calculated values along the entire structure or for its selected members. The displays include moments, shears, stresses, post-tensioning required, post-tensioning provided, tendon profile, deflections, and reinforcement required/provided. Each graph may be printed or exported as a .bmp or a metafile.

• ADAPT-PT input data is stored in a single file with the .ADB extension. However, the program is also backward compatible with input generated by earlier Windows versions of the program.

• ADAPT-PT is integrated into the ADAPT-Builder software suite. Structural models generated using the Modeler module of the Builder suite can automatically be transferred to ADAPT-PT for analysis and design. This capability provides a seamless link between the Finite Element Method of ADAPT-Builder and ADAPT-PT.
Chapter 2

GETTING STARTED
Installation:

1. Install the hardware Key (dongle) by inserting it into a USB or parallel port. If a printer is connected to the parallel port, the Key can be sandwiched between the printer cable and the computer parallel port. The insertion of the Key does not impact the normal operation of your computer.

2. Invoke the executable file on the program CD. An installation program will open and provide further instructions. Follow the screen instructions until setup is complete.

Execution:

1. Open the ADAPT-PT program by double-clicking on the icon on your desktop or navigating through your START menu.

2. To test the computer environment for compatibility with ADAPT software, select Open from the File menu and select the example MNL5-2.ADB in the Examples subdirectory. This test example is in US customary units. Use this example to verify that the program runs. When the program pauses and displays some of the interim results, click on the “EXIT” tool. This will conclude the design and prepare a report for you. After the execution stops, you can view the results.
Chapter 3

SIGN CONVENTION
The following is the sign convention used in ADAPT-PT.

**Applied loads**
Downward loads and counterclockwise moments are considered positive (Fig. 3.1 (a)).

**Span Actions**
Counterclockwise shear is considered positive.
Bending moment is considered positive if it causes tension at the bottom. Fig. 3.1 (b)

**Column actions**
Counterclockwise column moments are considered positive Fig. 3.1 (d).

Positive direction of frame as well as definition of right and left tributary region is defined as shown in Figure 3.1 (c).
Chapter 4

WORKSPACE
4. **OVERVIEW**

This chapter describes Graphical User Interface (GUI) for the main program screen and data input module of ADAPT-PT program.

All program functions, including data entry and program execution are accessed through the Main Program window. The data entry is done through separate program module called ADAPT-PT Input.

4.1 **THE MAIN PROGRAM WINDOW**

Figure 4.1-1 shows the main ADAPT-PT program screen as it appears once a project has been opened.
**Main Program Title Bar.** Contains program name and name and location of the opened file.

**Main Menu Bar.** Lists all available menus in main program window. Menu options will be grayed out when they are not applicable. For example, if there is no project open, the Save As, Close and Print options on the File menu will be grayed out.

**Main Toolbar.** Main Toolbar contains all available tools in the main program window. The tools will not be available when they are not applicable. For example:

- If you open ADAPT-PT program available tools are:

- If you open existing file the main toolbar contains the following options:

**Status Bar.** Status bar gives you information about project name, selected design code, units, execution mode, key type, current date and time. To turn Status Bar on or off go to View -> Status Bar.

**Hint Window.** Hint window gives you information on how to proceed if you want to edit, execute or view your structure. To close the Hint Window, right click anywhere on the screen.

### 4.1.1 Main Program Window Menu Items and Corresponding Tools

All options that can be accessed by the main program menus are listed below. For the commands that might be activated using the toolbar, the appropriate icon is displayed next to the feature.

#### 4.1.1.1 File Menu

The File Menu operations are:

**New.** Starts a new project. 

**Open.** Opens an existing project.
Save As. Saves both the input files and the results report file under a user-specified filename.

Save As Default Values. Once you save data using this option, the program will open all the new projects in the future using the values you saved. To change the default values, open a new file, modify the parameters of your choice, and re-save it using Save As Default Values.

Close. Closes the currently open project.

Delete Intermediate Files. Deletes all intermediate calculation files from the current project directory.

Export Graph. Allows the user to export the currently active graph as either a bitmap (.BMP) or a Windows metafile (.WMF).

Print. Prints the currently active report or graph window.

Page/Print Setup. Sets the paper size, report margins, paper orientation and printer.

Exit. Closes all windows and exits the program.

4.1.1.2 Action Menu

The Action menu operations are:

Enter/Edit Data. Opens the data input editor.

Execute Analysis. Executes the program calculations.

Recycle Window. Opens the recycling window. Used when re-running a project in order to adjust the post-tensioning force or profile.

4.1.1.3 View Menu

The View menu operations are:
**Status Bar.** Turns the status bar at the bottom of the main window on and off.

**Graphs.** The Graphs menu item opens a submenu, which allows any or all of the Results Graphs to be viewed. The Show Graphs button on the main toolbar displays all graphs.

**PT Summary.** Allows you to see result graphs for moments, forces, reinforcement and stresses for each load combination and envelope. Also it displays the report summary sheet.

### 4.1.1.4 Options Menu

The Options menu operations are:

**System of Units.** Allows the user to select the default units (American, SI, MKS).

**Design Code.** Allows the user to select the default code.

**Remember Printer Selection.** If this option is checked, the program uses the latest printer settings for all future runs, regardless of the default printer selected in the Windows settings.

**Report Setup.** Opens a Report Generator window where the report contents may be set.

**Graph Properties.** Configures the graphs generated by the program. Options include whether to include X and Y gridlines, min/max data points and a legend.

**Spreadsheet Options.** Configures the action of the ENTER key in the data entry spreadsheets. The key may be set to move the cursor right, down or stay in the same field.

### 4.1.1.5 Window Menu

The Window menu operations are:

This menu lists which of the graph windows are open. The graphs may be stacked vertically for scrolling, or the windows may be cascaded.
4.1.1.6 Help Menu

The Help menu operations are:

**About ADAPT.** Company address, phone, fax and e-mail information.

**About ADAPT-PT.** Program information such as version.

**Support Programs.** Information on how to obtain program support.

**Disclaimer.** Defines responsibility of the software user.

**Licensing.** Information on key type and status:

- **Key Type Selection.** Shows the current key selection and allows the user to choose a different key.

- **Local Key Status.** Indicates the status of the local protection Key.

- **Network Key Status.** Indicates the status of the network protection key.

- **Key Troubleshooting.** Provides information on troubleshooting problems with the key.

- **Calculator.** Invokes the standard windows calculation.

4.2 ADAPT-PT INPUT SCREEN

Project input data is created/edited through separate program module called ADAPT-PT Input. The input editor is used both to enter new projects and edit existing files.

- To enter a new project either click New on the File menu or click the New button, ![New Button](image), on the Main Toolbar.

- To edit existing file either click on Enter/Edit Data on the Actions menu on the Main Menu bar, or click the Edit Data button, ![Edit Data Button](image), on the Main Toolbar.
Figure 4.2-1 shows the ADAPT-PT Input screen as it appears once the input editor is opened.

FIGURE 4.2-1 ADAPT-PT INPUT SCREEN

**PT Input Title Bar.** Contains program name, and name and location of the opened file.

**PT Input Menu Bar.** Menu bar lists all available menus in ADAPT-PT Input.

**PT Input Toolbar.** This toolbar contains all available tools in the ADAPT-PT Input.

**Input Form.** Each input form is the dialog box that will prompt you to select options or enter required information. When first entering data for a project, you would typically go through the screens in order by clicking on the Next and Back
buttons or pressing ALT-N and ALT-B. In subsequent editing, specific screens may be selected from the PT Input menu.

If the input form contains a table (Fig. 4.2-2) the right mouse click will give you the following options:

- Insert a new line
- Delete line
- Copy selected lines
- Paste lines

![Figure 4.2-2 SPAN GEOMETRY INPUT SCREEN](image)

Each table contains a Typical row for fast input of data. The typical input row (top row) can be used if several rows in a column have same data. To enter typical values, type the value into the appropriate cell in the top row and then press ENTER. The typical value will be copied to all rows in the column. The value of any field initialized in this manner can be subsequently changed as necessary. Data can be entered in the typical row at random; it is not necessary to enter values in all fields of the typical row.

3D Structure View. Structure View window allows you to view the structure, loads, tendons, and rebar in 3D as you enter the data. You can also display the properties of each component if you bring the mouse pointer over it and right click. You can change the display in 3D window with View Tools toolbar. The toolbar function is explained in Section 4.2.1.11.

4.2.1 ADAPT PT-Input Menu Items and Tools

All options that can be accessed by the PT Input menus are listed below.

29
4.2.1.1 File

The menu items have the same function as File menu in the main program screen. (Section 4.1.1.1)

4.2.1.2 Project

This menu enables you to specify the project title, structural system and select analysis and design options through General Settings and Design settings input forms.

4.2.1.3 Geometry

This menu enables you to access input forms that you use to define geometry of a model. The input forms included in this menu are:

- Span geometry
- Effective Flange width
- Drop cap/transverse beam
- Drop panel
- Support geometry
- Boundary conditions

4.2.1.4 Loads

This menu opens the Loads input form where you can specify the loads.

4.2.1.5 Material

This menu enables you to access input forms where you can specify material properties for:

- Concrete
- Reinforcement
- Post-tensioning

4.2.1.6 Criteria

Criteria menu contains all input screens that you use to specify project criteria. The Criteria menu input forms are:
• Base Non-Prestressed reinforcement
• Allowable stresses
• Post-tensioning
• Calculation options
• Tendon profile
• Minimum covers
• Minimum bar extensions
• Load combinations
• Design code

4.2.1.7 Execute

If you click on the Execute menu the program will initiate an analysis. The corresponding tool is Save & Execute Analysis, in the Common toolbar.

4.2.1.8 Tools

The Tools menu allows you to convert units and change color settings. The menu items are:

• Convert units
• Color selection

4.2.1.9 Window

This menu lists which of the graph windows are open. The graphs may be stacked vertically for scrolling, or the windows may be cascaded.

4.2.1.10 Structure View

If you click on this menu it will open the 3D structure view.

4.2.1.11 View Tools Toolbar
This toolbar contains tools for selecting the entities that you want to be visible on the screen, as well as for creating rendered or shaded views of structural models. It is used to zoom in or out, pan, increase scale, create a screen shot and print.

- **Plan View.** It will show structure in plan view.

- **Elevation View.** It will show structure in elevation view.

- **Isometric View.** It will show structure in 3D isometric view.

- **Free Rotate Perspective View.**

- **Wire Frame.**

- **Transparent Shader.**

- **Solid Shader.**

- **Outline Shader.**

- **Show/Hide Gridlines.** Displays or hides gridlines and reference line.

- **Show/Hide Spans.** Displays or hides spans of the structural model.

- **Show/Hide Supports.** Displays or hides columns and walls of the structural model.

- **Show/Hide Drops/Beam.** Displays or hides drop caps and beams of the structural model.

- **Show/Hide Loads.** Displays or hides all loads that have been identified as “visible” in the Select/Set View Items window.
Show/Hide Rebar. Displays or hides the entire user defined (base) reinforcement.

Show/Hide Tendons. Displays or hides the entire tendons of the structural model.

Show/Hide Fixity. Displays or hides all fixity symbols of the supports.

Increase Scale Factor. This tool provides you with the option of distorting the dimension of the model in one or more direction, in order to obtain a better view of its details, such as magnifying the profile of a tendon within a slab thickness.

Select/Set View Items (Fig. 4.2-2). This button is used to set the display of the project items on the screen. Depending on which boxes you select, you can display additional information about each entity.

Dynamic Pan.

Rotate.

Zoom In.

Zoom Out.

Zoom Extents.

Dynamic Zoom.

Screen Capture. Takes a screen shot of the Structure View window.

Print. Prints currently active window.
FIGURE 4.2-2 3D DISPLAY SETTINGS DIALOG BOX
Chapter 5

BASIC PROGRAM OPERATIONS
5. **OVERVIEW**

This chapter explains the basic program operations.

5.1 **START A NEW PROJECT**

When starting a new project you should specify design code and system of units.

To start a new project:

1. Double-click on PT icon of your desktop to open the program.
2. Select File->New, or click on the New Input Session button, □.

5.2 **OPEN AN EXISTING PROJECT**

To open an existing project:

1. In the Main program window select File -> Open, or click on the Open Project button, □.
2. Select the .ADB file that you want to open.

Note: The four most recently accessed files will be recorded in File menu for easy access.

5.3 **SAVE INPUT DATA**

1. To save the input data and execute the analysis, either select Execute from the Input Editor menu or click on the Save & Execute Analysis button, □.

   o If you are entering a new project, you will be prompted for a file name and directory in which to save the file. Once the file is saved, the program will automatically execute the analysis.
If you opened an existing project, it will be saved to the same directory, under the same filename. The program will then automatically execute the analysis.

2. To save the input data and return to the Main Program window, select either Save or Save As from the Input Editor File menu or select the Save button, 
, on the Input Editor Toolbar.

   o If you have opened an existing file, Save will save the file under the same name, in the same directory.

   o Save As will allow you to change the file name and/or directory.

Once the file is saved, select Exit to return to the Main Program window.

5.4 SAVE INPUT DATA AS DEFAULT

Note that it is often not necessary to go through all of the screens, even when entering a new project. Much of the information on the Materials and Criteria input screens will be the same on many projects. The program is set up with ADAPT defaults for all screens.

To change the default values from ADAPT selected:

1. Open the file with the data you would like to save as default and use in other files.

2. Choose File->Save as Default. The program will save the file as “default” ADB file. Once you saved data using this option, the program will open all the future new projects using the values in the data you saved. To change the default values, open a new file, and re-save it using Save As Default Values.

5.5 SELECT SYSTEM OF UNITS

ADAPT PT features three systems of units: SI, MKS and American (known as Imperial).

To select system of units for the new project:
1. Double-click on the PT icon on your desktop to open the main program window.

2. Select Options -> System of Units.

3. Check one of the options: SI, MKS or American. The program will automatically close the Options menu.

5.6 CONVERT SYSTEM OF UNITS

To convert system of units:

1. Open an existing project.

2. Click on Edit Data tool, , to open Input Editor.

3. Select Tools -> Convert Units. The Convert-Units dialog box opens (Fig. 5.6-1).

4. Select New Unit and click Convert.

Note: The Convert Unit option is available only if the design code is ACI.

FIGURE 5.6-1 CONVERT UNITS DIALOG BOX
Chapter 6

STRUCTURAL MODELING
6 Overview

During the structural modeling step, the user defines the basic analysis and design parameters, i.e. the structural system (beam, one-way or two-way slab), the span lengths, cross-sectional geometries, tributary widths and supports. The user also defines the loading, allowable stresses and reinforcement covers. This is the most critical stage of the modeling process. The user’s experience and engineering judgment play a major role in the selection of suitable design parameters. This stage of the modeling should be performed, or at least reviewed, by a senior engineer. A structure that is not modeled correctly is not likely to yield reasonable results using ADAPT-PT or any other software.

Data entry in ADAPT-PT is independent from the execution of the analysis. Data for a particular project may be entered at any time for later execution. Data is entered through ADAPT-PT Input screens described in Section 4.2.

6.1 Project Information

Project information includes specification of general information and analysis and design options.

6.1.1 Specify General Project Information

The General Settings window automatically opens when a new project is started or an existing project is opened. This screen is also available through menu option Project -> General Settings.

![General Settings Input Screen](image)

FIGURE 6.1-1 GENERAL SETTINGS INPUT SCREEN
Input information as follows:

1. Type in General and Specific title. Note that the General title and Specific title of the project will appear at the cover page of a report and in the header of each page of a report.

2. Select Geometry input option.
   - If you model spans with uniform geometry where the tributary width, section type and/or section depth do not change within a span, select **Conventional** input. This will also give you an option to include drop caps, drop panels, and/or transverse beams.
   - If you model spans with non-uniform geometry within a span, select **Segmental** input.

3. Select a type of a Structural System.
   - If you select Two-Way slab you will have an option to include drop caps, drop panels and/or transverse beams.
   - If you select One-Way Slab you will have an option to include transverse beams only.
   - If you select Beam you will have an option to include an effective flange width in the calculations.

4. Click **Next**. This will save input data and open next input screen **Criteria – Design Code** where you can select design code.

### 6.1.2 Specify Analysis and Design Options

You can select various analysis and design options through the **Design Settings** dialog box (Fig. 6.1-2).

To specify analysis and design options:

1. Click on **Project->Design Settings**. The **Design Settings** input screen opens.
FIGURE 6.1-2 DESIGN SETTING INPUT SCREEN

2. Select Analysis options

   o **Automatic.** In the automatic mode, the program attempts to select a post-tensioning force and profile based on the parameters specified by the user. If a solution is possible, the program will complete all calculations and return to the Main Program window. The results can then be viewed and/or printed. If a satisfactory solution is not possible, the program will display a message box, which describes the problem and will switch to the interactive mode. The user can then decide whether it is possible to overwrite the original design criteria and continue with the design.

   o **Interactive.** The interactive mode gives the user an opportunity to optimize the design by adjusting the tendon forces and tendon drapes in each span.

   o If you select “Yes” for **Moment reduced to face-of-support**, the calculated moment at the support centerline will be adjusted to face-of-support and used in design.

   o If you select “Yes” for **Redistribute moments (post-elastic)**, the program will perform redistribution of moments and readjust elastic moments based on the provisions of the selected design code.

   o If you select “Yes” for **Use Equivalent Frame Method**, the program models the structure using the Equivalent
Frame Method (EFM). This option is available only for two-way systems.

- If you select “Yes” for **Increase Moment of Inertia Over Supports** the program will internally model the structure with increased moment of inertia over supports. This option affects the relative stiffness of the beam and column members. It also, in turn, affects the relative distribution of the moments and may affect the amount of post-tensioning required. The option is available for one-way systems and two-way systems where the Equivalent Frame Method is not used.

3. Select Design options

- If you select **Use all provisions of the code** the program will consider all provisions of the selected design code including calculation of minimum rebar for serviceability, check for cracking capacity and add reinforcement if needed, considering the contribution of posttensioning in strength check.

- If you select **Disregard the following provisions** you will have an option to choose which of the following provisions you would like to disregard in design:

  - If you choose to disregard **Minimum rebar for serviceability** the program will not report minimum rebar.

  - If you choose to disregard **Design capacity exceeding cracking moment** the program will not report the rebar due to design capacity exceeding cracking moment capacity.

  - If you choose to disregard **Contribution of prestressing in strength check** the program will not consider posttensioning in strength check. This scenario applies when a user adds tendons to a project for deflection or crack control.

- If data is being entered for a beam you will have an option to **Include the (DL + 25% LL) case of UBC**. This is a UBC (Uniform Building Code) requirement used to determine the amount of mild steel reinforcement required.
If this is answered “Yes,” the ratio of reduced live load to actual live load must be entered. This option allows a reduced live load to be used for the post-tensioning if so desired, but provides the full live load for the 25% UBC design loading. Live load reduction is optional; if the live load entered on the Loading screen was not reduced, the ratio of reduced to actual live load would be 1. Note that the (DL +25%LL) provision is not required by ACI-318, nor is it included in the IBC-2000 (International Building Code).

The program calculates and reports the moment capacity in both graphical and tabular format, based on the user selection.

- If you select Design values, the moment capacity will be calculated using the rebar and PT required for the design, including user defined base reinforcement.
- If you select User entered values, the moment capacity will be calculated only with user entered rebar (base rebar) and PT.

The moment capacity for the 1/20th points can be observed in the appropriate tabular report (Tabular Report-Detailed/ 34- Demand Moment and Moment capacity). The moment capacity graph is plotted together with the moment envelope (Fig. 6.1-3). To see the graph Open PTSum, select Envelope from the drop down list and click on Moment Diagram. Click on the Design Moment Capacity frame and select positive or negative moment capacities.
4. Specify the percentage of top and bottom reinforcement and posttensioning that will participate in resisting unbalanced moment. This option is available only for two-way systems.

5. Click Next. This will save input data and open a new input screen Span geometry where you can specify geometry of spans.

6.2 GEOMETRY

The geometry of the problem is defined via a series of input screens that can be accessed through the Geometry menu. The screens will vary depending on which structural system has been specified. There are three basic screens: Span Geometry, Support-Geometry, and Support-Boundary conditions. Additional screens are used to enter effective flange widths, segmental data, drop caps, drop panels, and transverse beams.

6.2.1 Specify Span Geometry

The span geometry can be modeled as prismatic (uniform) or non-prismatic (non-uniform).
The geometry without changes in cross-section along the span excluding geometry of drop cap, drop panels or transverse beams is called prismatic (uniform) geometry.

Geometry of a cross-section that changes along the span is called non-prismatic (non-uniform) geometry. You will have to model span geometry as non-uniform if at least one span is not uniform.

6.2.1.1 Prismatic (Uniform) Spans

The Span Geometry screen is used to enter the cross-sectional geometry of the slab or beam at midspan (Fig. 6.2-1).

To input data for uniform spans do the following:

1. Open Span Geometry.

2. To set the number of spans, use CTRL+/- or click on the up/down arrow at the left of the screen. If there are cantilevers on the right and/or left ends of the frame, add them by clicking on the appropriate check box. This will activate the input fields for the corresponding cantilever.

3. Select section type by clicking on the button in the Sec. column. Section type can be set to Rectangular, T section, I or L section, and Extended T section.

4. Enter the dimensions of the span sections. All dimensions are defined in the legend at the top of the screen and/or illustrated in the appropriate section figure.

   o Span lengths are measured from support centerline to support centerline.
The tributary width (dimension b) is composed of left tributary (the portion of the tributary width that falls to the left of the frame line) and the right tributary (the portion that falls to the right of the frame line). The tributary width can vary from span to span but is assumed to be constant within a single span unless segmental input is used.

There are two methods of modeling tributary width: Unit Strip input and Tributary input. Both methods produce the same results, which method to use is a matter of user preference. Once a method is selected however, it should be used consistently throughout a given project to avoid confusion. Note that the calculations and results are always shown in terms of the total tributary width, regardless of the way the slab was modeled during data entry.

Unit strip modeling (Fig 6.2-1A). It is typically easiest to model slabs with the unit strip method. A unit strip is a strip parallel to the span with a width equal to or less than the total tributary width. Although the unit strip width is typically 12 in. or 1000 mm, any reasonable value may be used. The unit width has no affect on the analysis as long as the total tributary width is modeled correctly. The tributary is modeled by specifying a unit strip width along with left and right multipliers. The left and right multipliers (←M and M→) indicate the number of times the unit strip needs to be multiplied to cover the left and right tributaries. The multipliers need not be whole numbers.
**FIGURE 6.2-1A**

**Tributary Modeling.** In tributary modeling, the total tributary width is entered as the ‘b’ dimension. The width multipliers (<-M and M->) are used to indicate how much of the tributary falls on either side of the frame line. The sum of the left and right multipliers should be one.

**Example:** Model the following tributary using A) unit strip method B) tributary method.

Total tributary = 300 in.
Left tributary = 180 in.
Right tributary = 120 in.

A) Unit strip method:

\[ b = 12 \text{ in.} \quad <-M = 15 \quad M-> = 10 \]

Total width = Left tributary + Right tributary =
\[ 12 \times 15 + 12 \times 10 = 180 + 120 = 300 \text{ in.} \]

B) Tributary method:

\[ b = 300 \text{ in.} \quad <-M = 0.60 \quad M-> = 0.40 \]

Total width = Left tributary + Right tributary =
\[ 300 \times 0.60 + 300 \times 0.40 = 180 + 120 = 300 \text{ in.} \]
5. Enter reference height (Rh). The reference height identifies the position of a reference line that is used in determination how to display tendon heights. The Rh indicates the distance from the reference line to the top of the slab with positive being measured upwards. Typically, the reference height is set equal to the slab depth.

Figure 6.2-2 shows several different reference height configurations. Typically, the same reference height is used for all spans. The reference height can thus be set via the typical row. If the slab or beam depth changes, the same reference height can still be used as long as the resulting tendon heights are adjusted accordingly when transferred to the structural drawings. Alternatively, the reference height can be entered as zero, which will set the reference line at the top of the slab. If the reference line is at the top of the slab, tendon heights will be shown as negative numbers indicating distance below the top of the slab.
FIGURE 6.2-2

The reference height can be changed from span to span to model steps at the top of the slab. If this is done, however, it will be necessary to adjust the tendon profiles so they match at the supports. In general, it is best to use the same reference height for all spans. Changes in the slab depth should be modeled accurately, however, to ensure that the calculations are done correctly.

6.2.1.2 Non-prismatic (non-uniform) spans

The following example illustrates data entry for a non-prismatic section using the segmental option. The example is a single span beam, which is made up of seven segments of varying cross-sectional geometries (Fig. 6.2-3).
Although this is not a practical design, it illustrates ADAPT’s ability to model complex geometries.

To model non prismatic span do the following:

1. Select Segmental in the General Settings input form.

2. Open Span Geometry (Fig. 6.2-4).

3. To set the number of spans, use CTRL+/- or click on the up/down arrow at the left of the screen. If there are cantilevers on the right and/or left ends of the frame, add them by clicking on the appropriate check box. This will activate the input fields for the corresponding cantilever.

4. Select section type by clicking on the button in the Sec. column.

5. Enter the dimensions of the span sections. All dimensions are defined in the legend at the top of the screen and/or illustrated in the appropriate section figure. The dimensions
specified in the **Span Geometry** screen including reference height and left and right multipliers define the geometry of a mid segment of the span. All other segments of the span are defined in the **Geometry-Span (More)** screen as explained in the following.

6. Change prismatic column **PR** to **NP**. Changing a span to **NP** activates the **More** button in the **Seg.** column.

7. Click on the **More** button in the **Seg.** column to open the **Geometry-Span (More)** window for that span (Fig. 6.2-5).

![FIGURE 6.2-5 GEOMETRY – SPAN (MORE) SCREEN](image)

8. To set the number of segments in the spans, use **CTRL+/-** or click on the up/down arrow at the left of the screen. Up to seven segments may be entered per span. The parameters are input in the same manner as general span geometry data except the **XL** column is used to specify the distance from the left support centerline to the start of the segment. The length of each segment is calculated automatically based on the distance to the start of the next segment. The start of the first segment is always zero.

Note that if either the **Use Equivalent Frame Method** or **Increase Moment of Inertia Over Support** option was selected, the program will automatically generate additional segments over each support using the geometry entered for the first and last segments. If the first and last segments are generated before the support dimensions are entered, their **XL** values will be initialized with values of zero and the
span length, respectively. These values will be updated when the support dimensions are entered.

9. Click OK to save input data and close Geometry-Span (More) window.

10. When you complete data input for all spans click Next to save the data and open next input screen Support Geometry and Stiffness.

6.2.2 Specify Effective Flange Width

If you enter a beam and you answer ‘Yes’ to Consider Effective Flange Width on the General Settings screen, the Span Geometry screen will be followed by the Effective Flange Width screen (Fig. 6.2-6). This screen is also available through menu Geometry -> Effective Flange Width.

![Effective Flange Width Input Screen]

FIGURE 6.2-6 EFFECTIVE FLANGE WIDTH INPUT SCREEN

1. Open Effective Flange Width input screen.

2. Select Effective width calculation method.
   - If you choose to use the ACI-318 method of effective flange width calculation, the resulting flange widths will be displayed, but you will not be able to edit them.
   - If you select User Input calculation, the effective width column $b_e$ will default to the ACI calculated values, but you will be able to change them.
3. Click Next to save data and go to the next input form.

Note: ACI does not actually specify an effective flange width for prestressed beams. The widths calculated by the program are in accordance with the ACI recommendations for non-prestressed beams.

6.2.3 Specify Geometry of Drop Cap and/or Transverse Beam

If you enter a two-way system and you answered “Yes” to the Include Drops & Transverse Beams question on the General Settings screen, the Span Geometry screen will be followed by the Geometry-Drop Cap/Transverse Beam screen (Fig. 6.2-7). This screen is also available through menu Geometry -> Drop Cap/Transverse Beam.

The input parameters are defined in the figures at the top of the screen. Note that **H**, the depth of the cap or beam, is the total depth of the section, not the depth below the slab.

**FIGURE 6.2-7 DROP CAP/TRANSVERSE BEAM INPUT SCREEN**

If there are drop caps or transverse beams with the same dimensions at several supports, their dimensions may be entered using the typical row. To enter typical values for drop caps, type the value into the typical row and press ENTER. The value will be copied to any supports that have been marked as having drop caps. Any supports which are subsequently marked as having drop caps will also be assigned this value as a default.

Transverse Beams dimensions are entered in the same manner.
6.2.4 Specify Geometry of a Drop Panel

If you enter a two-way system and you answered “Yes” to the **Include Drops & Transverse Beams** question on the **General Settings** screen, the **Drop Cap/Transverse Beam** screen will be followed by the **Geometry-Drop Panel** screen (Fig. 6.2-8). This screen is also available through menu **Geometry -> Drop Panel**.

![Figure 6.2-8 DROP PANEL INPUT SCREEN](image)

The data entries for drop panels are the same as for drop caps. Typical values can be entered with the typical row at the top of the table.

6.2.5 Specify Support Geometry and Stiffness

This screen is used to input support heights, widths and depths of supports (Fig. 6.2-9). Support selection options will change depending on the structural system you selected.
FIGURE 6.2-9 SUPPORT GEOMETRY AND STIFFNESS INPUT FORM

If you model a two-way system or a beam, the available support options will be:

- Lower column,
- Both columns,
- No columns

If you model a one-way system the support options will be:

- Lower wall,
- Both walls,
- Point support or transverse beam.

To model supports do the following:

1. Select lower, both or no support option.

2. Enter the height of lower supports (H1) if any. H1 is the distance from the mid-depth of the slab to the top of the slab below.

3. Specify cross section dimension for support:
   - If rectangular, enter data in column D (dimension in span direction) and B (dimension perpendicular to span direction).
   - If circular, enter data in column Dc (diameter of circular column).

4. Specify the percentage column stiffness that you would like to consider in analysis.

5. Repeat the procedure to define geometry of upper columns if any, or simply copy the data.

6. If you model a two-way system you will have an option to assign a Left edge and Right edge condition. This option is available only for two-way systems and it is used to determine column condition for punching shear check.
Chapter 6  STRUCTURAL MODELING

- If you select Exterior the program will automatically check the left and right tributary width. If the tributary that falls to the left or to the right side of the column is less than code required for interior column, the program will automatically consider it as an exterior column.

- If you select Interior the program doesn’t check left and right tributary width, and treats the column as interior.

Note: The program always checks left and right distance to the slab edge. If the dimension B of a column is at least 80% of tributary width the program will treat this column as wall and will not check it for punching shear.

6.2.6 Specify Support Boundary Conditions

This screen is used to enter support widths and column boundary conditions (Fig. 6.2-10).

1. Select Slab/beam boundary conditions at far ends.

   - Choose “No” if the slab end is rotationally free. This occurs when a slab/beam terminates over wall, column or beam.
Choose “Yes” if the slab end is rotationally fixed. This occurs if the span/beam end is tied to a structure that is rigid enough to prevent rotation. A typical example might be slab tied to a stiff shear wall. A rotationally fixed end condition can also be used to model half of a symmetrical, multi-span frame if there will be no rotation over the support at the line of symmetry.

Note: If there is a cantilever at the right or left end of span, the corresponding slab/beam end condition option will not be available.

2. Specify support width $SW$. This option is available if you choose “Yes” to the Reduce Moments to face-of-support in the Design Settings screen.

- To automatically set the values in $SW$ column to actual support widths, $D$, check box in front $SW = \text{Actual width of support}$. This option will not be available if you select no columns or point support transverse beam option for supports.

- To manually enter support width, uncheck box in front $SW = \text{Actual width of support}$ and input data.

3. Choose support boundary conditions by clicking on the arrow in the appropriate cell of the table. The following figure shows the available boundary conditions and symbols used in 3D view.

![Boundary Conditions](image)

**FIGURE 6.2-11 BOUNDARY CONDITIONS**

Note: If No Columns option was specified on the Supports-Geometry screen the boundary condition entries will be ignored. The support widths will be used to calculate reduced moments, however.
6.3 LOADS

ADAPT PT allows you to specify a variety of load types including dead, live, earthquake or wind loads (lateral loads).

6.3.1 Specify Dead, Live and Other loads

Figure 6.3-1 shows the screen used to enter loading information.

![Figure 6.3-1 LOAD INPUT FORM](image)

1. Specify loaded spans.
   - To enter load for an individual span, click on the arrow in cell of the **Span** column and select a span number from the list of all available spans, or just type in a span number.
   - To enter a load for all spans, enter ‘all’ or ‘ALL’ as the span number.
   - To enter loads on a left cantilever, enter either LC or 0 as the span number. To enter loads on a right cantilever, enter either RC or the number of spans +1 as the span number.

2. Specify the class of load by clicking on the arrow in the cell of a **Class** column. There are four available classes:
   - **SW** – selfweight. This load class will be available only if you select “No” for Include selfweight. In this case you have an option to enter selfweight of the structure manually instead of allowing the program to calculate it.
4. Specify the type of loading by typing U, P, C, M, L, R, V, or Z in the L/T-? column, or by dragging the icon from the graphics of the loading that you intend to apply to the cell in the L/T-? column. There are eight load types:

- U - Uniform,
- P - Partial uniform,
- C - Concentrated,
- M - Moment,
- L - Line,
- T - Triangle,
- V - Variable, and
- T - Trapezoidal.

Note: Uniform and partial loads are assumed to be uniformly distributed over the upper most surface of the member with a constant intensity per unit area. The user only needs to enter the loads intensity, and ADAPT calculates the frame loadings. These frame loadings are reported in report table 3.2 Compiled loading.

4. Enter load intensity and position. The schematics for each load type indicate the required input data. Note that on cantilevers, distances are always measured from the support (Fig. 3.3.10-2). The distances for a left cantilever are thus entered contrary to those of the typical spans.

Any number of different loads and load types may be entered for a span. You may also specify whether to skip the live loading and whether to
Chapter 6 STRUCTURAL MODELING

calculate selfweight automatically. If these features are selected, the skip factor and concrete unit weight must be entered.

6.3.2 Specify Lateral Loads

ADAP-PT allows you to specify lateral loads (wind or earthquake loads) as unbalanced concentrated moments acting at the face of supports. To define these loads:

1. Go to Criteria -> Load Combination.

2. Check Include Lateral Loads and click Set Values.

3. Go to Lateral moments tab and input values. (Fig. 6.3-3)

FIGURE 6.3-3 LATERAL INPUT DATA SCREEN

4. Click OK. The lateral moments will show on the screen.

6.4 MATERIAL

6.4.1 Specify Concrete Material

This screen is used to enter concrete properties (Fig. 6.4-1).
Depending on the code, the concrete weight classification is used in shear and/or flexure calculations. Default values of the modulus of elasticity are calculated based on the concrete strength and the appropriate code formula. The ultimate creep coefficient is used in the calculation of long-term deflections.

### 6.4.2 Specify Reinforcement Material

This screen is used to specify bar sizes and properties for longitudinal and shear reinforcement (Fig. 6.4-2).
When entering data for a beam and one-way slab, there will be an entry for preferred stirrup bar size and number of legs. When entering data for two-way slab there will be an option to select between stirrups and studs.

- If you select **Studs** the program will ask you to specify stud diameter and number of rails per side of a column.

- If you select **Stirrups** the program will ask you to specify stirrup bar size.

The preferred bar sizes are used when calculating the number of bars required. The bar sizes may be changed on the PT Summary report, however.

### 6.4.3 Specify Post-Tensioning Material

This screen is used to input the post-tensioning system parameters (Fig. 6.4-3)

![Image of Material - Post-Tensioning](image)

**FIGURE 6.4-3 PRESTRESSING MATERIAL INPUT SCREEN**

The information entered here is used to calculate the ultimate moment capacity of the member when the “effective force” option of the program is used. When the “tendon selection” option is used, the program calculates the effective stress. The stress in the tendon at nominal strength (f_p) is calculated from the effective stress and the reinforcement ratio.

### 6.5 CRITERIA
6.5.1 Specify the Design Code


To select the code:

1. Click Criteria -> Design Code. The Criteria-Design Code dialog box will open (Fig. 3.3.2-1)

2. Select the design code from the list.

3. Click Next. This will save input data and open a new input screen Design Settings where you can select your analysis and design options.

Note: Depending on the code chosen, materials factors and other design parameters may need to be entered. These are entered on the Load Combinations screen (Fig. 6.5-10). If you model in American or MKS units only ACI318 codes are available.

6.5.2 Specify Base Non-Prestressed Reinforcement

This screen is used to specify base non-prestressed reinforcement (Fig. 6.5-2).
The program allows you to specify a base reinforcement that is taken into consideration when designing the structure. You have an option to define reinforcement as mesh or isolated bars. The position of a bar is defined with distances of the first X1 and second X2 bar end to its immediate left support.

For example Bar 3 starts at 0.8 of Span 2 and ends at 0.2 of Span 3.

The user can see the base reinforcement in the 3D Structure View window as shown in Figure 6.5-3.
6.5.3 Specify Allowable Stresses

This screen is used to enter initial and final allowable stresses (Fig. 6.5-4).

Tension stresses are input as a multiple of the square root of $f'_{c}$, compression stresses are entered as a multiple of $f'_{c}$. The values entered for final allowable stresses will be shown on the Stresses Compression and Tension tab of the Recycle window.
6.5.4 Specify Recommended Post-Tensioning Values

This screen allows the user to specify minimum and maximum values for average pre-compression (P/A; total prestressing divided by gross cross-sectional area) and percentage of dead load to balance (W_{bal}) (Fig. 6.5-5).

![Criteria - Recommended Post-Tensioning Values](image)

These values are used by the program to determine the post-tensioning requirements shown on the Tendon Forces and Heights tab of the Recycle window. They are also used to determine the status of the Pmin/Pmax and Wbal Min/Max indicators on the Recycle window.

If data is being entered for a one-way or two-way slab, the bottom of the screen will ask for the maximum spacing between tendons. This is entered as a multiple of the slab thickness (i.e. 8 x slab thickness). The program does not check tendon spacing. However, this is something that must be checked on the shop drawings. Tendon spacing is typically more of an issue for detailing than design but on very thin, very lightly loaded slabs, it might govern the design.

6.5.5 Specify Calculation Options

This screen is used to select the post-tensioning design option (Fig. 6.5-6).
The two options are Force Selection and Force/Tendon Selection. Force Selection is the default option. In order to use Tendon Selection, the Force/Tendon Selection option must be specified.

If Force/Tendon Selection is specified, the screen will prompt for the information required to calculate the prestress losses. The values given as defaults are fairly typical in the industry and should be used unless more accurate information is available. Long-term losses may either be entered as a lump sum value, or the information required to calculate them may be entered.

6.5.6 Specify Tendon Profile

This screen allows the user to specify the tendon profiles (Fig. 6.5-7).
The parameters used to define the tendon are shown in the schematics at the top of the screen. The profile and values shown, a reversed parabola with the low point at mid-span and inflection points at span length/10, are the defaults. These are typical industry defaults; they will be appropriate for most designs with essentially uniform loading. Note that if a non-standard profile, i.e. a low point at somewhere other than midspan is used, this must be clearly called out on the structural drawings. Transfer girders and slabs with heavy concentrated loads may require a harped profile. The low point is usually specified to coincide with the column being transferred or the concentrated load.

Tendons in the model can have up to three different profiles. To define all three profiles fill in data in the tables of tab Tendon A, Tendon B, and Tendon C.

You have an option to define length and shape of tendon extension that terminates at the interior of a member. Left end data will apply to tendon Type B and Right end data will apply to tendon Type C.

**6.5.7 Specify Minimum Covers**

This screen is used to specify minimum covers for both the post-tensioning tendons and mild-steel reinforcement (**Fig. 6.5-8**).
Note that the cover for the pre-stressing steel is specified to the center of gravity of the strand (cgs) whereas, for mild steel, it is clear cover. For $\frac{1}{2}$ in. strand, the clear cover on the tendon will be $\frac{1}{4}$ in. less than the distance to the cgs.

### 6.5.8 Specify Minimum Bar Length

This screen is used to define how mild steel reinforcement bar lengths are calculated (Fig. 6.5-9).

The values entered for cut-off lengths are used to calculate top and bottom bar lengths when minimum reinforcement requirements govern. The lengths of bars required for ultimate strength are calculated from the reinforcement necessary to supplement post-tensioning at $\frac{1}{20}$th points along each span. Bar lengths for steel required for ultimate strength will include the specified extension lengths.
6.5.9 Specify Load Combinations

This screen is used to define the load combination factors for service, strength (ultimate), and initial load conditions. It also gives an access to the input screens for lateral loads and lateral loads combinations. (Fig. 6.5-10). It is also used to enter any applicable material factors or strength-reduction factors. The default values depend on selected design code.

FIGURE 6.5-10 CRITERIA- LOAD COMBINATION INPUT SCREEN

To define load combinations that include lateral loads check Include lateral load option and click Set Values. The Lateral Input Data window opens (Fig. 6.5-11).

FIGURE 6.5-11 LATERAL INPUT DATA INPUT SCREEN

If you answer “Yes” to the Do lateral loads change sign? question, the program will internally consider a new load combination with the modified sign of lateral load and report results for it. PT to resist Factored Moment option is used to specify the percentage of contribution of post-tensioning to unbalanced moment due to lateral loads. Note that
this option will not be available if in the Design Settings window you select to disregard contribution of prestressing in strength check.
7 OVERVIEW

The program can be executed either by selecting the **Execute Analysis** item on the **Action menu** or clicking the **Execute Analysis** button, on the **Main Toolbar**.

The program begins by reading the data files and performing a number of preliminary data checks. If an error is detected, the program will stop and display a message box indicating the most likely source of the error. The data consistency checks are not exhaustive, however, which means that the user is ultimately responsible for ensuring that the data is entered correctly.

The program can be executed in Automatic or Interactive mode. In the automatic mode, the program attempts to select a post-tensioning force and profile within the design bounds specified by the user. If a solution is possible, the program will complete the calculations and return to the Main Program window. The results can then be viewed and/or printed. If a satisfactory solution is not possible, the program will display a message box, which describes the problem and will switch to the interactive mode. The user can then decide whether it is possible to change the original design criteria and continue with the design.

The automatic mode begins by assuming the maximum drape for each span and determining the minimum force, which satisfies the maximum allowable tensile stresses. The same force is used for all spans. The force is then adjusted to meet the following requirements as specified by the user:

- Minimum percentage of dead loading to balance for each span;
- Minimum average precompression for each span; and,
- Maximum spacing of tendons (applies only to slabs).

After these initial adjustments, each span is checked for compliance with the following:

- Maximum percentage of dead loading to balance: if the balanced loading in any span exceeds the maximum percentage specified by the user, the program adjusts the tendon drape in that span in order to lower the balanced loading. It then recalculates the balanced loading and the related moments.
- Average precompression and compressive stresses: if either the average precompression or the compressive stresses exceed the
maximum permissible values, the program will stop and display a message box. It then switches to the Interactive mode and displays the Recycle window.

The interactive mode gives the user an opportunity to optimize the design by adjusting the tendon forces and tendon drapes in each span. It can be executed using either the Force Selection or Force/Tendon Selection mode.

The program begins by going through the same calculations that it goes through for the Automatic mode. After it has determined an initial tendon force and profile however, it displays the **PT Recycling** window shown in **Fig. 7-1**

![PT Recycling Window](image)

**FIGURE 7-1**

The **PT Recycling** window is comprised of five tabs which display information about the post-tensioning design, a Design Indicator box which summarizes the status of the current design, a Status indicator and four control buttons: Recycle, Recall, Graphs and Exit.

### 7.1 **PT RECYCLING WINDOW TABS**

The Pt Recycling Window tabs are:
Tendon Force & Heights Tab. This screen allows the user to select the tendon profile, adjust the tendon heights and post-tensioning forces (Fig. 7.1-1)

![Tendon Force & Heights Tab](image)

FIGURE 7.1-1

The table lists the post-tensioning forces at the midpoint of each span, the tendon heights at the left, center and right of each span, the average precompression at midspan (P/A mid) and the percentage of dead load balanced in each span (Wbal % DL) for current tendons and all tendons.

Adjustments in tendon force, and/or tendon height may change the average precompression and the percentage of dead load balanced. These changes are reflected in the P/A and Wbal columns as the changes are made. In order to see how the changes affect the stresses and average precompression at locations other than midspan, however, it is necessary to recycle the window.

Required and Provided PT Force Tab. The PT forces tab shows the PT forces provided in the left, center and right region of each span as well as the forces required in each region for minimum P/A and allowable tensile stresses (Fig. 7.1-2).
Chapter 7  PROGRAM EXECUTION

FIGURE 7.1-2

The post-tensioning force provided in each region is compared with the governing minimum force in that region as shown on the Required Forces tab. If the provided force does not envelop the required values, FORCE NG (No Good) is displayed in the indicator box at the top of the screen. Forces that are less than what is required will be highlighted in red in the Provided PT Force columns.

**Required PT Force Tab.** This tab shows the required post-tensioning forces for only the most recently calculated profile (Fig. 7.1-3).

FIGURE 7.1-3

Note that all values in the tables are forces and that these forces refer to the entire tributary width entered in the geometry input.
The window consists of three sections: The left (light blue) boxes display the governing forces for the left, center and right region of each span. The force selected for each region is the largest required force based on tensile stresses in that region, minimum P/A and minimum percentage of dead load to balance.

The middle (light yellow) boxes display the forces required for tensile stresses. If the moments in a particular region are such that no post-tensioning is required, a zero (0) is shown.

The first column of the right (light green) section is the post-tensioning force required to satisfy the minimum average precompression specified by the user, based on the member’s cross-sectional area at midspan (P/A mid). Average precompression P/A is not a function of the applied loading or tendon profile.

The second column of the right section (Wbal %DL) is the force required to provide an uplift equal to the minimum percentage of the total dead load specified by the user. The force required for each span depends on the tendon geometry and loading of that span. All the dead loads, including superimposed dead load, are summed for each span, regardless of whether they are self weight, uniform or concentrated. Note that when calculating Wbal for display on this screen, the downward tendon forces are not included. This approximation is made only for the purposes of obtaining a rapid screen display. The actual computations of moments and stresses include all forces in each tendon.

**Extreme Fiber Stresses Tab.** This tab shows the maximum tensile and compressive stresses in the left, center and right regions of each span (Fig. 7.1-4).
The stresses are calculated at 1/20th points and the highest stress in each region is displayed. If any of the stresses displayed are more than the allowable value, they will be highlighted in red. If the stress at any of the 1/20th points exceeds the allowable value, an NG warning is displayed in the indicator box. The location of the critical stress values can be determined by looking at the Stresses Recycle graph.

Tensile stresses are shown as a ratio of the square root of the concrete compressive strength at 28 days ($f'_{c}^{1/2}$). Compressive stresses are shown as a ratio of $f'_{c}$. The allowable stress values are shown for reference.

**Tendon Selection and Extents Tab.** This screen is used to edit tendons. The options in this window will change depending on the PT selection method you chose in recycling screen.

If you select Force selection the screen will allow you to change the tendon extents and stressing ends of short tendons (Fig. 7.1-5). To change tendon extents position the mouse cursor over the tendon end, press left mouse button and drag the end to its new location. To change tendon ends (Stressing/Fixed) position the mouse cursor over the tendon end, left-click while holding down Shift key.

If you select Tendon Selection you will be able to edit the number of tendons, change the length of short tendons and stressing ends (Fig. 7.1-6).
The status of the current design is summarized and displayed in the Design Indicator box at the top center of the Recycle window. Each design check is identified as either OK or NG (No Good).

The items displayed in the Design Indicator Box are as follows:

**Iteration No:** #. Each time a force or tendon height is adjusted and recycled, the program recalculates the related balanced loadings, moments, stresses, average precompression and percent of dead load balanced. Each set of calculations is referred to as a cycle. The number of cycles executed for a particular design is shown in the Iteration block. In most cases two to three cycles are adequate to arrive at an acceptable solution. It is rarely necessary to exceed five cycles.

**Weight of PT:** ### Lb/ft² or ### Kg/m². The weight of post-tensioning strand required to provide the selected forces is estimated and displayed in either pounds per square feet or kilograms per square meter.
Chapter 7 PROGRAM EXECUTION

The weight is estimated as follows: The force supplied by each strand is calculated based on its cross-sectional area and final effective stress, both of which are values input during data entry. The number of strands required to provide the forces shown on the Tendon Forces and Heights tab is then determined. The actual length of each strand is assumed to be its calculated length plus 3 feet (1 meter) to allow for a stressing tail. If the force changes between successive spans, it is assumed that the larger force extends over the common support and the tendons are anchored at 1/5 of the next span if otherwise specified by user. If the forces are modified, the weight is recalculated and displayed after the window is recycled.

**PT Force min OK  PT Force max OK.** This block compares the average precompression at midspan with the minimum and maximum values entered by the user. If the average precompression is above or below the specified limits, an NG is displayed.

Note that although the PT Force indicator considers the P/A all along the span, this block only considers the P/A at midspan. If the P/A is above or below the specified limits in a support region, the Pmin and Pmax indicators will show OK, however the PT Force indicator will show NG.

In two-way slabs with drops or transverse beams, for example, the cross-sectional area at the supports will be much larger than the cross-section at midspan. Providing the minimum P/A at the supports may result in a much higher PT force than necessary. Typically, the post-tensioning is adjusted so that the P/A at the supports is lower than the specified minimums. The Force indicator will thus show NG even if the P/A at midspan is within the specified limits.

The PT Forces tab (Fig. 7.1-2) shows the post-tensioning force required in each of the three regions of each span.

**Balanced DL Min OK, Balanced DL Max NG.** The total upward force of the tendon (Wbal) in each span is computed from the post-tensioning force in span and the tendon geometry in the span. This upward force is compared with the total dead loading on the respective span. An OK for both Wbal Min and Wbal Max means that the ratio of balanced loading to the total dead loading fell within the limits specified by the user in all spans. The percentage of dead load balanced in each span is shown on the Tendon Force & Heights tab (7.1-1). The force required to balance the specified minimum percentage of dead loading is shown on the Required Forces tab (Fig. 7.1-3).

**Stresses (service) or (initial): Tens OK, Comp NG.** This block compares the tensile and compressive stresses with the allowable values
specified by the user. The maximum stresses in each span are shown on the Extreme Fiber Stresses tab (Fig. 7.1-4).

7.3 RECYCLE WINDOW CONTROL BUTTONS

The Recycle button causes the stresses and required forces along the member to be recalculated based on the current tendon profile and forces.

If changes are made to either the tendon profile or force in any span, the status indicator at the top right of the Recycle window will begin to flash. Once all of the changes are made, click on the Recycle button to update all of the tabs, the Design Indicator box and the Recycle Graphs.

The Recall button allows the user to undo editing changes by recalling the tendon forces and profile from the previous recycle. After selecting Recall, the window must recycled again in order to update the tabs, the Design Indicator box and the graphs.

The Graphs button displays a set of three graphs which provide detailed information on the tendon profile, the tension and compression stresses and the required versus provided post-tensioning forces. The Recycle graphs are shown in Fig. 7.3-1.

The graphs are as follows:

**Tendon Height.** The Tendon Height graph can be used as a means of verifying that the tendon profile is at least reasonable. This graph allows the user to see the tendon profile either by itself or as it relates to the member elevation (concrete outline). This can be helpful for finding input errors such as a tendon profile that extends outside the member, or a profile that is not continuous. The concrete outline shows all steps, drop caps/panels, transverse beams and changes in thickness.
**FIGURE 7.3-1**

**Stresses.** This graph plots the maximum compressive and tensile stresses at the top and bottom face of the member. All types of loadings can either be shown separately or combined. The **Display allowable/computed stresses** options show the combined stresses along with an envelope of the allowable stresses. The graph provides easy interpretation of stress results and clearly shows if stress limits are exceeded.

**Post-tensioning.** This graph shows the required and provided post-tensioning force at 1/20th points along each span.

The graphs may be configured to show only certain spans and values by clicking on the check boxes at the left of the window. To maximize a graph for detailed viewing or change the display options, right-click on the desired graph and use the editing menu that opens up.

Selecting the **Exit** button closes the **PT Recycling** window and starts calculations of internal forces, deflection and reinforcement based on the most recent tendon force and profile.
selection. At the conclusion of the calculations, the user is returned to the Main Program window. The Results Report, the PT Summary Report and the Results Graphs may then be viewed and/or printed.

Note: If force or profile adjustments are made and you did not click on Recycle button before exiting, the program will automatically do a Recycle.

7.4 PT SELECTION METHOD

If you select Force/Tendon Selection option in the Criteria - Calculation Options screen you may choose between the Force selection and Tendon selection modes in the PT Recycling window (Fig. 7.4-1)

![PT selection method](image)

**FIGURE 7.4-1**

7.4.1 Force Selection Method

It assumes that a tendon will be assigned a final and constant effective force equal to the jacking force minus all stress losses expressed as a single representative value.

7.4.2 Tendon Selection Method

The Tendon Selection method is a newer, more accurate procedure than force selection method. In the Tendon Selection method, the post-tensioning force is assumed to vary along the length of the tendon. The variation accounts for stress losses in the tendon due to both immediate and long-term effects. It also includes consideration of the interaction between the various sources of loss. It is thus more accurate than procedures which account for losses as a lump sum approximation.

In Tendon Selection mode, the actual number of strands, as opposed to effective forces, may be specified. The user is able to see what the final stresses will be and can adjust the number of strands, the tendon profiles and the stressing ends as necessary. At each design section along a span,
Chapter 7 PROGRAM EXECUTION

the program performs an analysis based on the post-tensioning force at that section. Consideration is given to both short-term (friction, seating loss) and long-term (elastic shortening, creep, shrinkage, and relaxation of the prestressing steel) stress losses.

If the tendon profile is altered, friction and long-term losses are recalculated and the revised tendon forces are used for the computations. If the tendon forces have changed significantly, however, the selected profile may not be satisfactory. The solution thus becomes iterative since subsequent changes to the profile will also result in changes to the tendon forces. The iteration is automatically continued until an acceptable solution is reached.

7.4.2.1 Description of Features

**Tendon types.** For each member, up to three tendon types, A, B, and C, may be specified. Each type can be configured to have a different length and different stressing/fixed ends. A given tendon type may include one or more strands.

Figure 7.4-2(a) shows a five span beam with three different tendon arrangements. Tendon A extends the entire length of the beam and is stressed at both ends. It is shown in Fig. 7.4-2(b) as a straight line with two arrowheads representing the stressing ends.

The other two tendon types, B and C, start at either end of the beam and extend only part way through the member. The short vertical lines signify a fixed (non-stressing) end.

Figure 7.4-2(c) illustrates the shapes that the different tendon types can assume. Tendon type A must extend from one end of the member to the other. It can be stressed at one or both ends. Tendons types B and C can be configured the same as A, the same as one another, or completely different. They can be stressed at one or both ends.

Under normal conditions, the three tendon types will be configured differently. A post-tensioned member may not need all the three tendon types, however. Many members have only a Type A tendon. Type B and C tendons are typically configured to provide additional post-tensioning in end spans if necessary.
The number of strands in each type of tendon, and consequently the force in each tendon will usually be different. Tendons can have different profiles.

**Stress Loss Calculations.** There are two types of prestress losses:

- Immediate losses which occur at the time the tendon is stressed, and
- Long-term losses which may continue for several years.

The final effective force in the tendon is the jacking force minus all losses.

The immediate losses, friction and anchorage seating, are calculated based on the user-input friction parameters together with the tendon’s profile and stressing configuration. The stress in the tendon immediately after it is seated, with due allowance for friction and seating loss, is referred to as the initial or lock-off stress. Although friction coefficients are different for grouted
(bonded) and unbonded systems, the friction loss computations are essentially the same.

There are three options for long-term stress loss calculations:

- **Lump sum entry.** A lump sum value may be calculated by the user and entered during data input. The effective stresses in the tendon are calculated by subtracting this value from the initial stresses. Since the friction and seating losses cause the initial stresses to vary along the tendon, the effective stresses will also vary.

- **Long-Term Loss calculations for unbonded tendons.** For unbonded tendons, the strain in the tendon at any given point is not directly related to the local strain in the concrete. The program can calculate an average long-term loss value for the entire tendon based on the average precompression in the member and expected losses due to shrinkage, creep, elastic shortening and relaxation of the prestressing steel. The effective stresses in the tendon are calculated by subtracting the average long-term loss value from the initial stresses.

- **Long-Term Loss computation for grouted tendons.** Long-term stress losses in grouted tendons are a function of the local strain in the concrete. Long-term losses are thus computed at 1/20th points along the tendon. The effective stress at each point is the jacking stress minus the friction, seating loss and long-term stress losses at that point. The long-term losses are stored in the file LTLOSS.DAT. This is a text file and can be viewed with any text editor or word processor.

### 7.4.2.2 Description of Execution

The Tendon Selection & Extents tab (Fig. 7.4-3) becomes active when the Tendon Selection mode is chosen.
The left side of the tab shows the average force in each strand and the number of strands required and selected for each tendon type. The average force in each strand is the force after all losses. Note however that the average forces are not actually used in the calculations. They are displayed to provide the user with a measure of the relative efficiency of each strand type.

The right side of this screen shows a symbolic representation of the spans and the tendon layout. The default layout is a Type A continuous tendon stressed at both ends of the member, a Type B tendon stressed from the left and extending over the leftmost span and a Type C tendon stressed from the right and extending over the rightmost span.

You can edit the post-tensioning layout by:

- **Adjusting the tendon profiles.** Tendon heights are edited on the Tendon Force & Heights tab. Note that when the Tendon Selection option is active, you cannot access the Force column on this tab. In the Tendon Selection option, forces are calculated based on the number of strands and the final stresses in the strand.

- **Editing the number of strands in a tendon type.** The number of strands to use for each tendon type is shown in the Selected Number column. These numbers may be changed independently of one another. To delete a tendon type, set the number of strands to zero. To add a tendon type, enter the number of strands to use for that type.
o **Changing the stressing ends and/or extent of the tendons.** To change a tendon end from dead to stressing or stressing to dead, hold down the Shift key and left click once at the end of the tendon. Clicking a second time will change the tendon back to its original configuration. Note that the tendon must have at least one stressing end. To change the extent of a Type B or C tendon, position the cursor over the tendon end, hold down the left mouse button and drag the end to the desired location.

If any changes are made to the tendon profiles or number of strands, the window must be recycled to recalculate the force provided. There is no limit on the number of changes that can be made or the number of times the window can be recycled. Once an acceptable post-tensioning layout has been determined, select Exit to continue with the calculations.

Clicking on the Force Selection button at the top of the Recycle Window will toggle the program back to the Force Selection mode. Any changes that have been made while in the Tendon Selection mode will be reflected in the forces shown on the Tendon Force & Heights tab.
Chapter 8

VIEW/VALIDATE RESULTS
8 OVERVIEW

After the analysis is executed a graphical report can be generated. The PT summary module, ADAPT-PT Sum, enables you to generate comprehensive graphical reports for each ADAPT-PT run. You have an option to display and print results graphs for each load combination and generate a report that summarizes all post-tensioning parameters, rebar requirements and shear checks on a single page of output.

8.1 ADAPT-PT SUM SCREEN

To invoke ADAPT-PT Sum, click on the Open PTSum button, , or select the PT Sumary menu item from the View menu in the Main program window. The window will open as shown in Figure 8.1-1.
PT Sum Title Bar. Contains program name, and name and location of the opened file.

PT Sum Menu bar. Menu bar lists all available menus in ADAPT-PT Sum module.

PT Sum Toolbar. This toolbar contains all available tools in the ADAPT-PT Sum screen.

Status Bar. Status bar gives you information about units, current date and time.

Combination List. This is a drop down list that contains all available load combinations.

8.1.1 ADAPT-PT Sum Menu Items and Corresponding Tools

All options that can be accessed by the PT Sum program menus are listed below. For the commands that might be activated using the toolbar, the appropriate icon is displayed next to the feature.

8.1.1.1 File menu

Export Graph. Allows you to export the currently active result graph or summary report as either a bitmap (.BMP) file or a Windows metafile (.WMF). The graph or report must first be set up with the desired information and in the desired format.

Print. This tool prints active result graph with frame containing project information or active Summary Report.

When you print a graph the program will display the Print Graphs Option screen (Fig. 8.1-2) where you have an option to select sheet orientation and add additional comments that will appear at the bottom of the graph (Fig. 8.1-3).
Page/Print Setup. This option allows you to specify the printer, set the margins or the orientation of the reports.

Exit. Exits the PT Sum Module.

8.1.1.2 Graphs menu

Summary. When you select this option the Summary Report window will open with a default format for the Summary report as shown in Fig. 8.1-8.

View All Graphs. This option will show all available graphs for selected load combination or envelope.

Forces Diagram. This tool displays forces diagram for selected load combination or envelope (Fig. 8.1-4).
Moment Diagram. This tool displays bending moment diagram for selected load combination or envelope (Fig. 8.1-5).

Stresses Diagram. Displays calculated stresses for selected initial or service load combinations (Fig. 8.1-6).

Note: this tool will not be active if you select strength load combinations.
Rebar Diagram. Displays calculated rebar for the selected load combination or envelope. The graph shows required rebar calculated at 1/20th points and provided rebar (Fig. 8.1-7).

![Rebar Diagram](image)

**FIGURE 8.1-7**

8.1.1.3 Options menu

**Summary options.** Displays summary report setup window (Fig. 8.1-9 (a)-(c)). It has the same function as Report Setup button, on the Span Selection toolbar.

**Graph properties.** Configures the graphs generated by the program. Options include whether to include X and Y gridlines, min/max data points and a legend.

8.1.1.4 Window menu

This menu lists which of the graph windows are open. The graphs may be stacked vertically for scrolling, or the windows may be cascaded.

8.1.1.5 Help menu

**Contents.** Shows the help contents of ADAPT-PT.

8.1.1.6 Summary Report

The Figure 8.1-8 shows Summary report as it opens once you select Summary from Graphs menu, or click on Summary report button, in the main toolbar.
The format of Summary report can be modified using the Span Selection Toolbar. With this toolbar you can select which of the data blocks to print, or you can recalculate the mild steel requirements using a bar size which is different from what was initially specified in the ADAPT run. In addition, you can select to print the report in color or black-and-white, portrait or landscape, and on a variety of paper sizes. After the data blocks are selected, the report is automatically rescaled to fit the specified paper size. The following is the description of the Span Selection Toolbar.

Span Selection Toolbar

Report Setup. To specify what information to print, select the Report Setup. A window with three tabs will appear. Figure 8.1-9 (a-c) shows these three tabs:
• Use the check boxes on the ‘Sections to be printed’ tab to select which data blocks to print.

![Figure 8.1-9A](image)

**FIGURE 8.1-9A**

• Use the ‘Rebar Selection’ tab to change the bar sizes or bar system used for top and bottom reinforcing steel.

![Figure 8.1-9b](image)

**FIGURE 8.1-9b**

The bar system used for the ADAPT-PT analysis is determined according to the design code selected during data input. The preferred bar size is also specified during data input. Although these will be used as defaults for the Summary Report, both the bar system and bar size can be changed.

All of the bars systems shown on the Rebar Selection tab (ASTM - US Customary, ASTM - US SI, Euro or CSA) are available, no matter what design code was used for the ADAPT-PT run. First, select the desired bar system. Then, specify the top and bottom bar size from the pull-down list of bar sizes available for that
bar system. Click on Apply to recalculate the mild steel reinforcing requirements with the new bar sizes.

To go back to the bar system and sizes in the original ADAPT-PT run, select the ‘Use Input Data as Default’ option. Click on Apply to recalculate the number of bars required.

• Use the ‘Designer’s Notes’ tab to input notes that will be printed at the bottom of the report.

Click on the Apply button to apply the selected options to the report.

Page Setup. This tool gives you an option to print your report in portrait or landscape.

Color Settings. The tool gives you an option to print your report in color or black-and-white. This will change the color setup on both the screen and the printout.

Zoom options. The Zoom buttons can be used to adjust the size of the report on the screen.

Spans selection. Allows you to format the report to include only certain spans. From the left drop down list select first span and from the right drop down list specify last span that you want to include in the Summary Report.
The following is a description of the data blocks that can be included in the Summary Report:

**Data Block 1 - General Project Information**

<table>
<thead>
<tr>
<th>ADAPT - STRUCTURAL CONCRETE SOFTWARE SYSTEM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADAPT-FT Version  &quot;8.08&quot; Date  &quot;03-05-2007&quot; Time  &quot;17:38&quot; File Mni5-2</td>
</tr>
<tr>
<td>1 - PROJECT TITLE: &quot;Example 1&quot;</td>
</tr>
<tr>
<td>2 Design Strip</td>
</tr>
<tr>
<td>2 Load Case: SERVICE + Min LL +1.00 SVD +0.30 LL Min +1.00 SDL +0.30 XL +1.00 FT +0.00 HYP +0.00 LAT</td>
</tr>
</tbody>
</table>

Data block 1 contains the General and Specific titles entered during data input.

**Data Block 2 – Member Elevation**

Data block 2 contains an elevation view of the member with span dimensions. It also includes a graphical representation of the tendon profile that shows inflection points and low points. An elevation view of the member, including all drops and steps, with span lengths and the post-tensioning tendon profile, including inflection points and low points.

**Data Block 3 – Top Rebar**

Data block 3 reports the amount and length of rebar required at the top of the member. The rebar shown is the larger of the steel required to withstand the negative moment demand and code-specified minima.

If the steel required is controlled by the negative-moment demand, the bar lengths are based on the required rebar quantities at 1/20th points. The selected rebar is calculated as two lengths in an effort to minimize material requirements. This is particularly helpful for cases where rebar requirements vary and a large amount of reinforcing is required over a short section of the span. In these cases, using bars that are all the same length might be an unnecessary waste of materials.
Note that the steel selected by the program is only one of several acceptable design solutions. Space has been provided in this data block for the designer to provide alternate information on rebar quantity, size and length. The designer may also use this space to write in any additional notes or remarks pertaining to the rebar.

**Data Block 4 – Tendon Profile**

Data block 4 shows an elevation view of the tendon profile. Tendon control points are marked and their heights with respect to the reference line are given. If the computer run was done in the Force Selection mode, the program shows the total post-tensioning force in each span. If the Tendon Selection option was used, the elevation view also includes the total number of tendons, the location of all dead and live stressing ends, and any added tendons. Heights of tendon control points with respect to the reference line and the total post-tensioning force or total number of strands specified for each span.

**Data Block 5 – Bottom Rebar**

Data block 5 reports the amount and length of rebar required at the bottom of the member. The format is the same as data block 3 – Top Rebar.

**Data Block 6 – Required & Provided Bars**
Data block 6 plots the rebar required and provided for the top and bottom of the section at each 1/20th point. The maximum required areas of steel required for the top and bottom of each span are also shown.

**Data Block 7 – Shear Stirrups / Punching Shear (One-Way Shear)**

For beams, data block 7 reports the stirrup size and spacing based on user input during data entry. The spacing shown is the maximum spacing along the different segments of the span. The data block also includes a bar graph of the area of shear reinforcement required along each span.

This block is typically not included on reports for one-way slabs since shear reinforcement is seldom required. Although this block may indicate that shear reinforcement is required at the supports for a one-way slab, a review of the Results Report will show that this is for beams only.

Note: the shear diagram is only available for strength and envelope load combinations.

**Data Block 7 – Shear Stirrups / Punching Shear (Two-way Shear)**

For two-way slabs, data block 7 plots an elevation view of the model, which indicates the punching shear stress ratio at each support and states whether the stress ratio is acceptable per the specified code. Note: This
block is available only if you select Envelope from the drop down list of load combinations on the Main toolbar.

### Data Block 8 – Legend

| 8 - LEGEND               | ← Stressing End | ← Dead End |

Data block 8 identifies the symbols used to indicate stressing and dead ends. Note, however, that the stressing and dead ends are only shown when the Tendon Selection option has been used for the analysis. The legend is not applicable if Force Selection was used.

### Data Block 9 – Design Parameters

<table>
<thead>
<tr>
<th>9 - DESIGN PARAMETERS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code: AC 203</td>
</tr>
<tr>
<td>Concrete strength, $f_c$</td>
</tr>
<tr>
<td>Mild steel yield strength, $f_y$ for longitudinal and shear reinforcement</td>
</tr>
<tr>
<td>Ultimate tendon strength, $f_{pu}$</td>
</tr>
<tr>
<td>Minimum Top and Bottom rebar cover</td>
</tr>
<tr>
<td>Rebar Table</td>
</tr>
</tbody>
</table>

Data block 9 reports the following design parameters used in the ADAPT-PT run:

- Design Code
- Concrete strength, $f_c$
- Mild steel yield strength, $f_y$ for longitudinal and shear reinforcement
- Ultimate tendon strength, $f_{pu}$
- Minimum Top and Bottom rebar cover
- Rebar Table

### Data Block 10 – Designer’s Notes

Data block 10 contains notes added by the designer. The entry in this box will be used on future runs and future projects until it is cleared. To clear the notes, select Clear and then click on Apply in the ‘Designer’s Notes’ tab of Report Setup.

The Summary Report can be viewed in final form on the screen. It can then be printed or saved as either a .WMF or .BMP or copied and pasted to a word processor. If it is saved as a file, it can be inserted into contract documents, calculation packages or structural drawings.
9 OVERVIEW

This section describes in detail the reports generated by the ADAPT-PT program for one-way slabs, two-way slabs, and beams. It is primarily intended for those who are using the report in their designs, or those who review structural designs based on the ADAPT Post-tensioning Software System.

The material presented identifies the input parameters by the user, the parameters which the user may edit during the execution of the program, and finally those which are computed by ADAPT. The reports clearly identify the values input by the user from those calculated by the program.

Each report is broken down into sections. Each section is given a unique identification number. The report consists of those sections that are selected by the user. Hence, the content and details of a report are user controlled. However, the user can save selected report content as templates.

9.1 REPORT GENERATOR SCREEN

To create a report click on the Report Setup button, on the Main toolbar. The Report Generator window opens (Fig. 9.1-1).
**List of All Sections.** It includes a tree that lists the sections available in the report. To select a section, checkmark the box in front the section. To exclude the section uncheck the box. Note that the section will not be shown in the report tree if not applicable. For example, if your structural system is a beam, the punching shear report will not be available.

**List of Selected Sections.** It lists all sections that you checkmarked to be included in your report.

- **Remove Selection.** Removes highlighted selection from the drop down list.
- **Save Selection.** Adds your settings to the drop down list.
- **Save as Default.** Saves the current selections as default.
- **Create New Report.** Generates report and displays them in rich text format (.RTF) when completed.
- **Browse Reports.** Opens already created reports.
- **Update Company Info.** Allows you to customize report footer and cover page.
- **Exit.** Exits Report Generator and goes back to the ADAPT Main program window.

### 9.2 HOW TO CREATE REPORT

To create reports, go through the following steps:

1. First set the report to show your company information when you create the report documents. To do so click on the **Update Company Info** button. The **Company Information** dialog box opens.
FIGURE 9.2-1

In the **Company Information** edit box, specify the text that you would like to include in the footer of each page of your report. To upload the company’s logo, click on the **Browse** button and upload Bitmap or JPEG file of your logo. The logo will show on the report cover page. Once you set up your company information the program will use it whenever you create new reports. If left blank, the program will use default ADAPT information.

2. Click **OK** to close **Company Information** edit box.

3. In the **Report Generator** tree, select the sections that you would like to include in your report. The selection will appear at the right side of the window in the List of Selected Sections.

4. Click on **Create New Report** button. The program will ask you to specify name and location where you would like to save your report. The default location is the .ADB file folder where your project is saved.

5. Click **OK**. The program will start generating the report. Once completed, the program will open the report in rich text format. The report content will include sections you selected and they will be shown in default program settings. You will be able to modify it as you wish.

### 9.3 DESCRIPTION OF REPORT SECTIONS

The main report sections available are:

- Report cover page
• Table of contents
• Concise report
• Tabular report-compact
• Tabular report-detailed
• Graphical reports
• Legend

The following explains each of these sections:

9.3.1 Report Cover Page

The program-generated cover page will contain a company logo, title, bitmap of a 3D structure view, and date (Fig. 9.3-1). The cover page will be created only if you select the Report Cover option from the list of sections.

Your company logo will appear at the top of the report cover page and will show the bitmap or JPEG file that you uploaded (Fig 9.2-1). The default cover page title will be the Generic title and Specific title of your project that you specified in the General Settings window of PT Input. While in PT Input you can set the structure view as you want it to appear on the cover page of your report. When you exit PT Input (click on Close button, or click Execute), the program will take a screen shot of the 3D structure and show it on the cover page. At the bottom of the cover page the program shows the date when you created report.
9.3.2 Table of Contents

To include a table of contents with your report, select the Table of Contents section in the Report Generator tree. The table will contain only sections that were selected by user and listed in the Selected Sections of the Report Generator window. The following table includes all sections available in ADAPT-PT report.

TABLE OF CONTENTS:

Concise Report

A. - Project Design Parameters and Load Combinations
   A.1 - Project Design Parameters
   A.2 - Load Combinations

B. - Design Strip Report
   B.1 - Geometry
   B.2 - Applied Loads
   B.3 - Design Moments
      Envelope
   B.4 - Tendon Profile
   B.5 - Stress check / Code check
      Envelope
Chapter 9 REPORTS

B.6 - Rebar Report
B.7 - Punching Shear
B.8 - Deflection
B.9 - Quantities

Tabular Reports - Compact

1 - User Specified General Analysis and Design Parameters

2 - Input Geometry
   2.1 Principal Span Data of Uniform Spans
   2.2 Detailed Data for Nonuniform Spans
   2.3 Effective Width Data of Uniform Spans
   2.4 Effective Width Data for Non-Uniform Spans
   2.5 Drop Cap and Drop Panel Data
   2.6 Transverse Beam Data
   2.7 Support Width and Column Data

3 - Input Applied Loading
   3.1 - Loading As Appears in User's Input Screen
   3.2 - Compiled Loads

4 - Calculated Section Properties
   4.1 Section Properties of Uniform Spans and Cantilevers
   4.2 Section Properties for Non-Uniform Spans

5 - Moments, Shears and Reactions
   5.1 Span Moments and Shears (Excluding Live Load)
   5.2 Reactions and Column Moments (Excluding Live Load)
   5.3 Span Moments and Shears (Live Load)
   5.4 Reactions and Column Moments (Live Load)

6 - Moments Reduced to Face of Support
   6.1 Reduced Moments at Face of Support (Excluding Live Load)
   6.2 Reduced Moments at Face of Support (Live Load)

7 - Selected Post-Tensioning Forces and Tendon Profiles
   7.1 Tendon Profile
   7.2 Selected Post-Tensioning Forces and Tendon Drape
   7.3 Tendon Extents and Stressing Conditions
   7.4 Required Minimum Post-Tensioning Forces
   7.5 Service Stresses
   7.6 Post-Tensioning Balance Moments, Shears and Reactions

8 - Factored Moments and Reactions Envelope
   8.1 Factored Design Moments (Not Redistributed)
   8.2 Reactions and Column Moments
   8.3 Secondary Moments
   8.4 Factored Design Moments (Redistributed)

9 - Factored Lateral Moments Envelope
   9.1 Input Lateral Moments
   9.2 Factored Lateral Moments (Not Redistributed)
   9.3 Factored Lateral Moments (Redistributed)
10 - Mild Steel (No Redistribution)
  10.1 Required Rebar
  10.1.1 Total Strip Required Rebar
  10.2 Provided Rebar
  10.2.1 Total Strip Provided Rebar
  10.2.2 Total Strip Steel Diposition

11 - Mild Steel (Distributed)
  11.1 Required Rebar
  11.1.1 Total Strip Required Rebar
  11.2 Provided Rebar
  11.2.1 Total Strip Provided Rebar
  11.2.2 Total Strip Steel Diposition

12 - Shear Reinforcement
  12.1 Shear Calculation Envelope

13 - Punching Shear Reinforcement
  13.1 Critical Section Geometry
  13.2 Critical Section Stresses
  13.3 Punching Shear Reinforcement

14 - Deflections
  14.1 - Maximum Span Deflections

15 - Friction, Elongation and Long Term Stress Losses
  15.1 Friction and Elongation Parameters
  15.2 Calculated Stresses
  15.3 Summary
  15.4 Critical Stress Ratios

Tabular Reports - Detailed

21 - Tendon Heights

22 - Post-Tensioning Balanced Loading

23 - Detailed Moments

24 - Detailed Shears

25 - Factored Moments and Reactions

26 - Factored Lateral Moments

27 - Detailed Stresses

28 - Required Post-Tensioning

29 - Detailed Rebar

30 – Punching Shear Reinforcement

32 – Unbalanced Moment Reinforcement
34 - Demand Moment and Moment Capacity

**Graphical Reports**
- PT-Force
- PT-Profile
- Deflection
- Load Cases
- Load Combinations

**Legend**

9.3.3 **Concise Report**

The concise report is the short version of the report that includes all information necessary to describe project input and results.

Sections of concise report are:

- Project Design Parameters
- Design Strip Reports

Project Design Parameters includes information common to the entire project and can be printed as evidence that data in design criteria was properly entered into the program. It includes:

- Material properties
- Covers
- Code
- Allowable stresses
- Load combinations
- Other common entries for all support lines.

Design Strip Report includes:

- Definition of geometry (annotated graphics)
- Applied loads (annotated graphics)
• Tendon layout and values (graphics) with information on force, tendon height
• Stress check results
• Rebar report
• Punching shear
• Deflection graph
• Quantities

The following is the example of concise report:
A. Design Parameters and Load Combinations

A.1 Project Design Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concrete</td>
<td></td>
<td>Minimum Cover at BOTTOM</td>
<td>1.00 in</td>
</tr>
<tr>
<td>$F'c$ for BEAMS/SLABS</td>
<td>4000.00 psi</td>
<td>Post-tensioning</td>
<td></td>
</tr>
<tr>
<td>For COLUMNS/WALLS</td>
<td>4000.00 psi</td>
<td>SYSTEM</td>
<td>UNBONDED</td>
</tr>
<tr>
<td>$E_c$ for BEAMS/SLABS</td>
<td>3605.00 ksi</td>
<td>$F_{pu}$</td>
<td>270.00 ksi</td>
</tr>
<tr>
<td>For COLUMNS/WALLS</td>
<td>3605.00 ksi</td>
<td>$F_{se}$</td>
<td>175.00 ksi</td>
</tr>
<tr>
<td>CREEP factor</td>
<td>2.00</td>
<td>Strand area</td>
<td>0.153 in 2</td>
</tr>
<tr>
<td>CONCRETE WEIGHT</td>
<td>NORMAL</td>
<td>Min CGS from TOP</td>
<td>1.00 in</td>
</tr>
<tr>
<td>Tension stress limits / $(f'c)^{1/2}$</td>
<td>At Top</td>
<td>Min CGS from BOT for interior spans</td>
<td>1.00 in</td>
</tr>
<tr>
<td></td>
<td>6.000</td>
<td>Min CGS from BOT for exterior spans</td>
<td>1.00 in</td>
</tr>
<tr>
<td></td>
<td>At Bottom</td>
<td>Min average precompression</td>
<td>125.00 psi</td>
</tr>
<tr>
<td></td>
<td>6.000</td>
<td>Max spacing / slab depth</td>
<td>8.00</td>
</tr>
<tr>
<td>Compression stress limits / $f_c$</td>
<td>At all locations</td>
<td>Analysis and design options</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.450</td>
<td>Structural system - Equiv Frame</td>
<td>TWO-WAY</td>
</tr>
<tr>
<td>Reinforcement</td>
<td></td>
<td>Fy (Main bars)</td>
<td>60.00 ksi</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Moments reduced to face of support</td>
<td>YES</td>
</tr>
<tr>
<td>Fy (Shear reinforcement)</td>
<td>60.00 ksi</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Moment Redistribution</td>
<td>NO</td>
</tr>
<tr>
<td>Minimum Cover at TOP</td>
<td>1.00 in</td>
<td>DESIGN CODE SELECTED</td>
<td>ACI-318 (1999)</td>
</tr>
</tbody>
</table>

A.2 Load Combinations

Strength load combinations
1. $1.4 \text{ SW} + 1.7 \text{ LL} + 1.4 \text{ SDL} + 1.7 \text{ X} + 1 \text{ HYP}$

Service load combinations
Sustained Load
1. $1 \text{ SW} + 1 \text{ LL} + 1 \text{ SDL} + 1 \text{ X} + 1 \text{ PT}$

Initial load combinations
1. $1 \text{ SW} + 1.15 \text{ PT}$

Lateral load combinations:
1. $U = 1.2 \text{ SW} + 1 \text{ LL} + 1.2 \text{ SDL} + 1 \text{ X} + 1 \text{ Sec} + 1 \text{ Lat}$
2. $U = 0.9 \text{ SW} + 0.9 \text{ SDL} + 1 \text{ Sec} + 1 \text{ Lat}$
B. Design Strip Report: TWO-WAY THREE SPAN
B.1 Geometry

- Plan

- Elevation
B.2 Applied loads

- Superimposed Dead Load

- Live Load

- Lateral Load
**B.3 Design Moment**

**LOAD COMBINATION: Envelope**

Moment Diagrams

- Project: "TWO-WAY EQUIVALENT FRAME SLAB EXAMPLE FOR A D A P T"  / Load Case: E
- Moment Drawn on Tension Side
- Load Case: E
- Moment is drawn on tension side

**DESIGN MOMENT**

**B.4 Tendon Profile**

**Tendon Height Diagram**
B.5 Stress check results / Code check

LOAD COMBINATION: Envelope

Stress Diagrams
Project: "TWO-WAY EQUIVALENT FRAME SLAB EXAMPLE FOR ADAPT" / Load Case: En
Tensile Stress Positive

SERVICE COMBINATION STRESSES
(Tension stress positive)
B.6 Rebar Report

Base Reinforcement
Isolated bars

<table>
<thead>
<tr>
<th>Span</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Cover</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>1</td>
<td>TOP</td>
<td>.00</td>
<td>5</td>
<td>5</td>
<td>1.50</td>
<td>72.59</td>
<td>1.55</td>
</tr>
</tbody>
</table>

Mesh Reinforcement

<table>
<thead>
<tr>
<th>#</th>
<th>Span</th>
<th>Location</th>
<th>From</th>
<th>Spacing</th>
<th>Size</th>
<th>Cover</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>BOT</td>
<td>.00</td>
<td>12.00</td>
<td>4</td>
<td>1.50</td>
<td>19.17</td>
<td>3.60</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>BOT</td>
<td>.00</td>
<td>12.00</td>
<td>4</td>
<td>1.50</td>
<td>27.17</td>
<td>3.60</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>BOT</td>
<td>.00</td>
<td>12.00</td>
<td>4</td>
<td>1.50</td>
<td>22.75</td>
<td>3.60</td>
</tr>
<tr>
<td>CR</td>
<td>BOT</td>
<td>.00</td>
<td>12.00</td>
<td>4</td>
<td>1.50</td>
<td>3.50</td>
<td>3.60</td>
<td></td>
</tr>
</tbody>
</table>

Total Strip Provided Rebar

<table>
<thead>
<tr>
<th>Span</th>
<th>ID</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>TOP</td>
<td>0.00</td>
<td>1</td>
<td>5</td>
<td>4.00</td>
<td>0.31</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>TOP</td>
<td>15.33</td>
<td>2</td>
<td>5</td>
<td>9.50</td>
<td>0.62</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>TOP</td>
<td>21.74</td>
<td>4</td>
<td>5</td>
<td>10.00</td>
<td>1.24</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>TOP</td>
<td>18.20</td>
<td>1</td>
<td>5</td>
<td>5.50</td>
<td>0.31</td>
</tr>
</tbody>
</table>

B.7 Punching Shear

Critical Section Stresses

<table>
<thead>
<tr>
<th>Label</th>
<th>Layer</th>
<th>Cond.</th>
<th>Factored shear</th>
<th>Factored moment</th>
<th>Stress due to shear</th>
<th>Stress due to moment</th>
<th>Total stress</th>
<th>Allowable stress</th>
<th>Stress ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>1</td>
<td>-247.80</td>
<td>+21.29</td>
<td>0.12</td>
<td>0.003</td>
<td>0.124</td>
<td>0.181</td>
<td>0.683</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>1</td>
<td>-265.96</td>
<td>+9.29</td>
<td>0.13</td>
<td>0.001</td>
<td>0.132</td>
<td>0.181</td>
<td>0.725</td>
</tr>
<tr>
<td>4</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

Punching Shear Reinforcement

Reinforcement option: Shear Studs
Stud diameter: 0.38
Number of rails per side: 1

<table>
<thead>
<tr>
<th>Col.</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Dist. = Distance measured from the face of support
Note: Columns with --- have not been checked for punching shear.
Note: Columns with *** have exceeded the maximum allowable shear stress.

B.8 Deflection
DEFLECTION

B.9 Quantities

CONCRETE
Total volume of concrete = 1088.85ft³ (40.33 yd³)
Area covered = 1306.62 ft²

MILD STEEL
Total weight of rebar = 1342.75 lbs
Average rebar usage = 1.03 psf, 1.23 pcf

PRESTRESSING MATERIAL
Total weight of tendon = 600.3 lb
Average tendon usage = 0.46 psf, 0.55 pcf

9.3.4 Compact Report

The compact report consists of the mirror image of user input, plus a tabular listing of critical information, such as post-tensioning and reinforcement, necessary for preparation of structural drawings. Also, it includes values of actions, such as moments, shears and stresses at left center and right of each span.

The following is the description of the available report sections:

9.3.4.1 Section 1- User Specified General Analysis and Design Parameters

This data block reflects the user’s input in the selection of post-tensioning design parameters and the design options.
Some of these parameters, such as the ultimate strength of strand and mild reinforcement, enter the design with the values as shown in this data block. Others, such as tendon cover, are the initial values set by the user at the start of analysis. During the execution of the program, the user has the option to modify some of the initial design parameters listed in this data block.

The following are parameters which enter the computations as recommended initial values, but can be edited during the execution of the program. The final values are listed in the output section of the report.

- Tendon CGS (Center of Gravity of Strand) at top of support and midspans: these are the user-suggested values. The actual cover used in the calculations are listed in Section 7 of the report.

- Minimum average precompression shows the value set by the user. The actual average post-tensioning is listed in Section 7 of the report.

- Max spacing between strands is also entered by the user. Refer to Section 7 where the force provided by each tendon reveals whether or not this postulation is adhered to.

- Tension stress limits are defined as multiples of the \( \sqrt{f_c} \). Based on these values, the required post-tensioning along the member is determined. Specifying a set of permissible values in this data block is no guarantee that the final stresses are, in fact, equal or less than the limits stated. During execution the user may overwrites the previously
set stress limits with the selected post-tensioning. The actual stresses are reported in data sections Section 7 of the report.

The following input data cannot be altered during the execution of the program:

- Reinforcement: This data block refers to the non-prestressed reinforcement in the beam/slab. The values for beam stirrups, where applicable, are given in Section 12 of the report.

- Post-tensioning system: indicates the user’s selection between grouted (bonded) or unbonded post-tensioning. The average effective stress in a strand \( f_{se} \) is the user’s estimate of the stress in a strand after all losses have taken place. This value is used in the determination of the ultimate strength of a section if the “force selection” option of the program is used. It affects the amount of supplemental rebar which may be required to meet the strength stipulations of a section. If the “variable force” option (tendon selection) is used, the program does not use this value. It calculates the applicable stress.

- Analysis option used: If the answer to moments reduced to face-of-support is YES, it indicates that the calculated centerline moments at each support are adjusted to face-of-support. In addition to the centerline moments, ADAPT prints out the moments reduced to face-of-support. Refer to moment data blocks for the description of printed values.

- Moment of Inertia over support: The beam or slab region over the width of a support (columns or walls) exhibits a greater stiffness than the unsupported regions. ADAPT has an option to allow for this greater stiffness by increasing the moment of inertia of region over the support. The increase is determined by a relationship proposed in ACI-318.

**9.3.4.2 Section 2: Input Geometry**

This data block reports model geometry as input by the user. It includes basic span geometry, effective width used in calculations, drop can, drop panel, transfer beam dimensions as well as support width and column dimensions. The geometry is described as follows:
2.1 Principal Span Data of Uniform Spans. This section is available only if the user selects conventional geometry input.

<table>
<thead>
<tr>
<th>Span</th>
<th>Form</th>
<th>Length</th>
<th>Width</th>
<th>Depth</th>
<th>TF Width</th>
<th>TF Thick.</th>
<th>BF/MF Width</th>
<th>BF/MF Thick.</th>
<th>Rh</th>
<th>Right Mult</th>
<th>Left Mult</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>19.17 ft</td>
<td>120.00 in</td>
<td>12.00 in</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10.00</td>
<td>0.50</td>
<td>0.50</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>27.17 ft</td>
<td>120.00 in</td>
<td>12.00 in</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10.00</td>
<td>0.50</td>
<td>0.50</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>22.75 ft</td>
<td>120.00 in</td>
<td>12.00 in</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10.00</td>
<td>0.50</td>
<td>0.50</td>
</tr>
<tr>
<td>C</td>
<td>1</td>
<td>3.50 ft</td>
<td>120.00 in</td>
<td>12.00 in</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10.00</td>
<td>0.50</td>
<td>0.50</td>
</tr>
</tbody>
</table>

2.2 Detailed Data for Nonuniform Spans. This section is available only if the user selects segmental geometry input.

2.2 Detailed Data for Nonuniform Spans

<table>
<thead>
<tr>
<th>Span</th>
<th>Seg.</th>
<th>Form</th>
<th>Left Dist.</th>
<th>Width</th>
<th>Depth</th>
<th>TF Width</th>
<th>TF Thick.</th>
<th>BF/MF Width</th>
<th>BF/MF Thick.</th>
<th>Rh</th>
<th>Right Mult</th>
<th>Left Mult</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
<td>0.00</td>
<td>24.00</td>
<td>30.00</td>
<td>216.00</td>
<td>8.00</td>
<td></td>
<td></td>
<td>10.00</td>
<td>0.56</td>
<td>0.44</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>2</td>
<td>0.33</td>
<td>24.00</td>
<td>30.00</td>
<td>216.00</td>
<td>8.00</td>
<td></td>
<td></td>
<td>10.00</td>
<td>0.56</td>
<td>0.44</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>2</td>
<td>5.00</td>
<td>24.00</td>
<td>30.00</td>
<td>216.00</td>
<td>8.00</td>
<td></td>
<td></td>
<td>10.00</td>
<td>0.56</td>
<td>0.44</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>1</td>
<td>18.42</td>
<td>24.00</td>
<td>30.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10.00</td>
<td>0.50</td>
<td>0.50</td>
</tr>
</tbody>
</table>

The following is the description of the data:

Span. This column shows the span number (ID). If the problem has a cantilever at left, its data precedes the first span by a line starting with “C.” Likewise, in the case of a cantilever at right, the last line will start with “C” describing the geometry of the right cantilever.

Seg. This column shows the segment number (ID).

Form. Identifies the cross-sectional geometry of the slab at midspan. Figure 9.3-2 illustrates the cross-sectional options. The same figure also gives the definition of parameters Depth, Width, TF Width (top flange width), TF Thick. (Top flange thickness), BF/MF Width (bottom flange/middle flange width) and BF/MF Thick. (bottom flange/middle flange thickness).
**Length.** The centerline-to-centerline distance between adjacent supports for each span.

**Rh (Reference height).** The distance from a user-specified reference line to the top of the slab. For example, if a slab is 7” thick and Rh is set to 7”, the datum is located at the slab soffit. This data identifies the location from which tendon height control points are measured, and is also used to input steps in a member.

**Right or Left (Width) Multiplier.** A parameter which describes the factor by which the slab unit strip must be multiplied to cover the total tributary of a given span.

---

### Table: Cross-sectional Geometries

<table>
<thead>
<tr>
<th>Type</th>
<th>Cross-sectional Geometries</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. RECTANGLE SECTION</td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
<tr>
<td>2. T OR I SECTION</td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td>3. M equal S SECTION</td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
<tr>
<td>4. EXTENDED T OR I SECTION</td>
<td><img src="image4" alt="Diagram" /></td>
</tr>
</tbody>
</table>

**FIGURE 9.3-2**

---

**TABLE 9.3-1**

<table>
<thead>
<tr>
<th>Type</th>
<th>Cross-sectional Geometries</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. RECTANGLE SECTION</td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
<tr>
<td>2. T OR I SECTION</td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td>3. M equal S SECTION</td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
<tr>
<td>4. EXTENDED T OR I SECTION</td>
<td><img src="image4" alt="Diagram" /></td>
</tr>
</tbody>
</table>
It should be noted that the results printed in the output, such as the moments and reactions, refer to the total tributary unless indicated otherwise.

2.3 Effective Width Data of Uniform Spans. This section applies to Conventional geometry input.

<table>
<thead>
<tr>
<th>Span</th>
<th>Effective Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>57.51</td>
</tr>
<tr>
<td>2</td>
<td>81.51</td>
</tr>
<tr>
<td>3</td>
<td>68.25</td>
</tr>
</tbody>
</table>

Effective Width Data for Non-Uniform Spans. This section applies to Segmental geometry input.

<table>
<thead>
<tr>
<th>Span</th>
<th>Seg.</th>
<th>Effective Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>57.51</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>57.51</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>57.51</td>
</tr>
</tbody>
</table>

Span. This column shows the span number (ID). If the problem has a cantilever at left, its data precedes the first span by a line starting with “C”. Likewise, in the case of a cantilever at right, the last line will start with “C” describing the geometry of the right cantilever.

Seg. This column shows the segment number (ID).

Effective width. Mirrors the data in the Geometry-Effective Flange width input form

2.5 Drop Cap and Drop Panel Data. This data block gives the dimensions of drop caps/panels for each support. Figure 9.3-4 illustrates the definition of data columns 2 through 10.

<table>
<thead>
<tr>
<th>Joint</th>
<th>Cap T</th>
<th>Cap B</th>
<th>Cap DL</th>
<th>Cap DR</th>
<th>Drop TL</th>
<th>Drop TR</th>
<th>Drop B</th>
<th>Drop L</th>
<th>Drop R</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>36.00</td>
<td>48.00</td>
<td>0.00</td>
<td>24.00</td>
<td>0.00</td>
<td>30.00</td>
<td>100.00</td>
<td>0.00</td>
<td>50.00</td>
</tr>
<tr>
<td>2</td>
<td>36.00</td>
<td>48.00</td>
<td>24.00</td>
<td>24.00</td>
<td>24.00</td>
<td>30.00</td>
<td>100.00</td>
<td>50.00</td>
<td>50.00</td>
</tr>
<tr>
<td>3</td>
<td>36.00</td>
<td>48.00</td>
<td>24.00</td>
<td>24.00</td>
<td>24.00</td>
<td>30.00</td>
<td>100.00</td>
<td>50.00</td>
<td>50.00</td>
</tr>
<tr>
<td>4</td>
<td>36.00</td>
<td>48.00</td>
<td>24.00</td>
<td>24.00</td>
<td>24.00</td>
<td>30.00</td>
<td>100.00</td>
<td>50.00</td>
<td>50.00</td>
</tr>
</tbody>
</table>

For example, Cap T, which is the heading of column 2, is shown at the bottom right hand side of Fig. 9.3-4 to indicate the total depth
of “CAP.” STEP 1 in the figure indicates the first thickening of the slab past the support, and is referred to as DROP CAP regardless of its size. The second change in thickness is called DROP PANEL, or STEP 2.

![Diagram of slab and support](image)

**FIGURE 9.3-4**

If no drop caps nor panels are present, zeros are shown in this data block. A zero indicates that the user has not entered any value for a parameter. However, as far as the computations are concerned, ADAPT selects a minimum default value if necessary. For example, CAPT equal zero will result in a default value of CAPT equals span thickness for calculations.

### 2.6 Transverse Beam Data
Transverse beam data are reported in the table of Section 2.5.

### 2.7 Support Width and Column Data
This data block is only printed if columns data are input, or if support widths are specified for reduction of moments to face-of-support. Otherwise the following sentence is printed: “NO COLUMN STIFFNESS IS INCLUDED IN THE ANALYSIS.”
**Support Width.** Is the support width at each joint. These values are used in the reduction of moments to the face-of-support. This value may be different from the column dimensions.

**Length LC.** Is the height of the lower column measured from the center of the slab to the top of the bottom slab.

**Length UC.** Is the height of the upper column measured from the center of the slab to the bottom of the top slab.

**B(DIA).** Is the dimension of the column cross-section normal to the direction of the frame. A circular column is entered using B(DIA) only.

**D.** Is the column dimension parallel to the frame.

**CBC** is the Column Boundary Condition parameter. B and D can also describe the horizontal dimensions of the structural element supporting the slab, such as the thickness and length of a continuous wall. Whether or not a given wall/column support dimensioned through B and D is taking moments is determined by the manner in which the wall/column is connected to the slab. The nature of the connection of the support to the slab at the slab/support junction is indicated by the CBC parameter as defined by the user and reflected in columns 6 and 10 of this data block. Note that the CBC parameter also describes the condition of fixity of the column at its far end away from the beam/slab, namely at its connection to the slab above and the slab/footing below.

% is the percentage of the column stiffness included in the analysis.

### 9.3.4.3 Section 3: Input Applied Loading

This data block reports model geometry as input by the user. Loads entered by the user are sorted according to the span on which they act and are listed in the loading data block.
3.1 Loading As Appears in User's Input Screen. This section mirrors the data as shown in the Loads input screen.

<table>
<thead>
<tr>
<th>Span</th>
<th>Class</th>
<th>Type</th>
<th>W</th>
<th>P1</th>
<th>P2</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>F</th>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LL</td>
<td>U</td>
<td>0.120</td>
<td></td>
<td></td>
<td>ft</td>
<td>ft</td>
<td>ft</td>
<td>k</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>SDL</td>
<td>U</td>
<td>0.250</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3.2 Compiled loads. This section shows frame loads calculated by the program. If you specified uniformly distributed or partial loadings, the program will calculate frame loading based on the tributary width.

<table>
<thead>
<tr>
<th>Span</th>
<th>Class</th>
<th>Type</th>
<th>P1</th>
<th>P2</th>
<th>F</th>
<th>M</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>Reduction Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LL</td>
<td>P</td>
<td>2.160</td>
<td></td>
<td>0.000</td>
<td>19.170</td>
<td>0.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>SDL</td>
<td>P</td>
<td>4.500</td>
<td></td>
<td>0.000</td>
<td>19.170</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Class. Specifies load class for each span. Class LL is live load, class SDL is superimposed dead load, class SW is selfweight and class X is other loading.

Type. There are 8 different load types:

- **U** is for a uniformly distributed load acting on the entire tributary.
- **C** is for a concentrated load. It acts at a point entered by the user and measured from the left support of the respective span.
- **P** is for a partial uniform load that acts on the entire width (tributary) of a span over the length entered by the user.
- **M** is for an applied moment that acts on the entire tributary at a distance from the left support entered by the user.
- **Li** is for a Line load that acts along the frame line of the slab. Line loads are entered in the same manner as partial loads.
- **R** is for triangle load that acts along the frame line of the slab.
- **V** is for variable load that acts along the frame line of the slab.
• T is for trapezoidal load that acts along the frame line of the slab.

The user can also select the selfweight option. Using the geometry and unit weight entered by the user, ADAPT calculates the selfweight of the entire beam/slab and automatically amends the loading file. The value of the selfweight loading will appear in the output data.

Live load is not skipped unless stipulated by the user, in which case the following sentence appears at the end of the loading table:

LIVE LOADING is SKIPPED with a skip factor of x.xx

The skip factor specified by the user will appear in lieu of x.xx shown above.

When the skip load option is activated, ADAPT obtains two sets of solutions. (i) In the first set, live loading is assumed to act without the skip factor on all spans. (ii) In the second set, live load multiplied by the specified skip factor is selectively placed on different spans. Solutions of the second set are combined to yield the maximum possible negative and positive moments at each location. Results of moment combinations from (i) and (ii) are then merged to arrive at the governing moments for design.

9.3.4.4 Section 4: Calculated Section Properties

The data block on section properties gives the cross-sectional area, moment of inertia, and the location of the neutral axis of the entire tributary perpendicular to the direction of the span.

4.1 Section Properties of Uniform Spans and Cantilevers. The table below shows the data for rectangular cross-sections.

<table>
<thead>
<tr>
<th>Span</th>
<th>Area</th>
<th>I</th>
<th>Yb</th>
<th>Yt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in²</td>
<td>in⁴</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>4448.00</td>
<td>0.44E+06</td>
<td>22.44</td>
<td>13.56</td>
</tr>
<tr>
<td>2</td>
<td>4448.00</td>
<td>0.44E+06</td>
<td>22.44</td>
<td>13.56</td>
</tr>
<tr>
<td>3</td>
<td>4448.00</td>
<td>0.44E+06</td>
<td>22.44</td>
<td>13.56</td>
</tr>
</tbody>
</table>

In the case of flanged T-beams, there are two cross-sectional properties computed. One is for the section reduced by “effective” width, and the other is for the entire tributary. The reduced values
are used for flexure of the member and the total values for inplane (axial) loads. The Section 4.1 is then as shown below.

<table>
<thead>
<tr>
<th>Span</th>
<th>Area</th>
<th>Yb</th>
<th>Yt</th>
<th>b_eff</th>
<th>i</th>
<th>Yb</th>
<th>Yt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in²</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>4448.00</td>
<td>22.44</td>
<td>13.56</td>
<td>57.51</td>
<td>0.6052E+07</td>
<td>17.71</td>
<td>18.29</td>
</tr>
<tr>
<td>2</td>
<td>4448.00</td>
<td>22.44</td>
<td>13.56</td>
<td>57.51</td>
<td>0.2421E+06</td>
<td>17.71</td>
<td>18.29</td>
</tr>
<tr>
<td>3</td>
<td>4160.00</td>
<td>17.79</td>
<td>12.21</td>
<td>100.00</td>
<td>0.2250E+06</td>
<td>15.00</td>
<td>15.00</td>
</tr>
</tbody>
</table>

### 4.2 Section Properties for Non-Uniform Spans

The table below shows the data for rectangular cross-sections.

<table>
<thead>
<tr>
<th>Span</th>
<th>Seg.</th>
<th>Area</th>
<th>I</th>
<th>Yb</th>
<th>Yt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>in²</td>
<td>in⁴</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>4448.00</td>
<td>0.6052E+07</td>
<td>17.71</td>
<td>18.29</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>4448.00</td>
<td>0.2421E+06</td>
<td>17.71</td>
<td>18.29</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4160.00</td>
<td>0.2250E+06</td>
<td>15.00</td>
<td>15.00</td>
</tr>
</tbody>
</table>

For T-flanged beams the data are shown as follows:

<table>
<thead>
<tr>
<th>Span</th>
<th>Seg.</th>
<th>Area</th>
<th>Yb</th>
<th>Yt</th>
<th>b_eff</th>
<th>i</th>
<th>Yb</th>
<th>Yt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>in²</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in⁴</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>4448.00</td>
<td>22.44</td>
<td>13.56</td>
<td>57.51</td>
<td>0.6052E+07</td>
<td>17.71</td>
<td>18.29</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>4448.00</td>
<td>22.44</td>
<td>13.56</td>
<td>57.51</td>
<td>0.2421E+06</td>
<td>17.71</td>
<td>18.29</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4160.00</td>
<td>17.79</td>
<td>12.21</td>
<td>100.00</td>
<td>0.2250E+06</td>
<td>15.00</td>
<td>15.00</td>
</tr>
</tbody>
</table>

The calculated section properties are given in terms of span segments, for both customary and segmental input geometries. A non-segmental span with no drop caps or drop panels has one segment. A span with drop caps at either end has three segments. A span with drop caps and drop panels has five segments. Finally, a segmental span can have up to seven segments.

Yt and Yb refer to the distance of the neutral axis to the top and bottom fibers.

When there is a change in cross-section of a span at the line of support, as shown in the idealized Fig. 9.3-5(a), two options regarding the face-of-support arise. Over the support line, ADAPT considers the cross-section at the face-of-support of the shallower member to be the same as that of the deeper member. But, recognizing that the deeper span does not penetrate into the shallower one, ADAPT assumes a zero length for the geometry of the deeper section into the shallower span. The same assumption is used for change of geometry over the supports of finite width as shown in Fig. 9.3-5(b).
If the analysis is done with finite support widths, and the user has included the option to increase moment of inertia over the support, then ADAPT adds an additional segment over each support.

9.3.4.5 Section 5: Moments, Shears and Reactions

Values given as moments, shears and reactions all refer to the total tributary and not the unit strip. Moments in this data block are moments at the center of supports (system line moments).

5.1 Span Moments and Shears (Excluding Live Load).

<table>
<thead>
<tr>
<th>Span</th>
<th>Load Case</th>
<th>Moment Left</th>
<th>Moment Midspan</th>
<th>Moment Right</th>
<th>Shear Left</th>
<th>Shear Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SDL</td>
<td>0.00</td>
<td>83.70</td>
<td>-246.03</td>
<td>-30.30</td>
<td>55.97</td>
</tr>
<tr>
<td>2</td>
<td>SDL</td>
<td>-247.29</td>
<td>147.79</td>
<td>-287.62</td>
<td>-59.65</td>
<td>62.62</td>
</tr>
<tr>
<td>3</td>
<td>SDL</td>
<td>-287.33</td>
<td>133.69</td>
<td>-27.56</td>
<td>-62.61</td>
<td>39.77</td>
</tr>
<tr>
<td>CANT</td>
<td>SDL</td>
<td>-27.56</td>
<td>-----</td>
<td>-15.75</td>
<td>-----</td>
<td>-----</td>
</tr>
</tbody>
</table>

Moment Left and Moment Right relate to centerline moments in the slab at the left and right of each span respectively.

Moment Midspan refers to the moment at midspan. The moment at midspan is not necessarily the largest value. For the location and value of the maximum moment refer to Section 23 that gives detailed report at 1/20th points.

Shear Left and Shear Right are the centerline shear forces at the left and right of each span.
5.2 Reactions and Column Moments (Excluding Live Load)

<table>
<thead>
<tr>
<th>Joint</th>
<th>Load Case</th>
<th>Reaction</th>
<th>Moment Lower Column</th>
<th>Moment Upper Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SDL</td>
<td>30.30</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>SDL</td>
<td>115.61</td>
<td>-1.26</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Reaction is the centerline dead load reaction at each support line.

Moment Lower Column and Moment Upper Column are upper and lower dead load column moments and are given for each support at the connection of column to slab/beam. If a support does not have a column, or if moment transfer between the support and slab is inhibited by the user through the specification of an appropriate column boundary condition, a zero (0) is printed.

Live load moments, shears and reactions are values reported at the center of supports and refer to the entire tributary.

5.3 Span Moments and Shears (Live Load). This section is a summary of maximum and minimum live load moments, and corresponding shear forces at the left and right centerlines, as well as at center span.

<table>
<thead>
<tr>
<th>Span</th>
<th>Moment Left Max</th>
<th>Moment Left Min</th>
<th>Moment Midspan Max</th>
<th>Moment Midspan Min</th>
<th>Moment Right Max</th>
<th>Moment Right Min</th>
<th>Shear Left</th>
<th>Shear Right</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k</td>
<td>k</td>
</tr>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.00</td>
<td>46.96</td>
<td>46.96</td>
<td>-104.52</td>
<td>-104.52</td>
<td>-15.25</td>
<td>26.16</td>
</tr>
<tr>
<td>2</td>
<td>-104.66</td>
<td>-104.66</td>
<td>54.55</td>
<td>54.55</td>
<td>-118.43</td>
<td>-118.43</td>
<td>-23.95</td>
<td>24.96</td>
</tr>
</tbody>
</table>

Maximum and minimum values at a section may occur due to the skipping of live loading.

5.4 Reactions and Column Moments (Live Load). This section is a summary of the maximum and minimum live load reactions and column moments given for each support at the connection of column to slab/beam.

<table>
<thead>
<tr>
<th>Span</th>
<th>Reaction Max</th>
<th>Reaction Min</th>
<th>Moment Lower Column Max</th>
<th>Moment Lower Column Min</th>
<th>Moment Upper Column Max</th>
<th>Moment Upper Column Min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k</td>
<td>k</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>15.25</td>
<td>15.25</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>50.10</td>
<td>50.10</td>
<td>-0.14</td>
<td>-0.14</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

If a support does not have a column, or if moment transfer between the support and slab is inhibited by the user through the
specification of an appropriate column boundary condition, a zero (0) is printed in the “moment” columns.

These are minimum and maximum centerline values based on skipped loading case.

Values given as moments, shears and reactions all refer to the total tributary and not the unit strip. Moments in this data block are system line moments.

9.3.4.6 Section 6: Moments Reduced to Face of Support

If the option of reducing moments to the face-of-support is invoked by the user, ADAPT adjusts the centerline moments to the face-of-support. The adjustments are based primarily on support widths. The adjusted values are printed in Sections 6.1 and 6.2.

6.1 Reduced Moments at Face of Support (Excluding Live Load)

<table>
<thead>
<tr>
<th>Span</th>
<th>Load Case</th>
<th>Moment Left</th>
<th>Moment Midspan</th>
<th>Moment Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SDL</td>
<td>9.85</td>
<td>83.67</td>
<td>-205.33</td>
</tr>
<tr>
<td>2</td>
<td>SDL</td>
<td>-203.83</td>
<td>147.75</td>
<td>-241.92</td>
</tr>
</tbody>
</table>

6.2 Reduced Moments at Face of Support (Live Load)

<table>
<thead>
<tr>
<th>Span</th>
<th>Moment Left Max</th>
<th>Moment Left Min</th>
<th>Moment Midspan Max</th>
<th>Moment Midspan Min</th>
<th>Moment Right Max</th>
<th>Moment Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>4.96</td>
<td>4.96</td>
<td>46.97</td>
<td>46.97</td>
<td>-85.50</td>
<td>-85.50</td>
</tr>
<tr>
<td>2</td>
<td>-87.25</td>
<td>-87.25</td>
<td>54.55</td>
<td>54.55</td>
<td>-100.25</td>
<td>-100.25</td>
</tr>
</tbody>
</table>

This data block only appears if user selected to reduce moments to the face-of-support.

9.3.4.7 Section 7: Selected Post-tensioning Forces and Tendon Profiles

7.1 Tendon Profile Tendon profile types available in the library of the ADAPT version used are listed in this data block.
**Tendon A**

<table>
<thead>
<tr>
<th>Span</th>
<th>Type</th>
<th>X1/L</th>
<th>X2/L</th>
<th>X3/L</th>
<th>A/L</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>0.050</td>
<td>0.500</td>
<td>0.080</td>
<td>---</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>0.070</td>
<td>0.500</td>
<td>0.070</td>
<td>---</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>0.070</td>
<td>0.500</td>
<td>0.070</td>
<td>---</td>
</tr>
<tr>
<td>CR</td>
<td>2</td>
<td>0.000</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

**Type.** Reflects the profile type chosen for each span. Parameters X1/L, X2/L, X3/L and A/L are the horizontal distance ratios selected for the profiles used. These are illustrated in **Fig. 9.3-6.** Some parameters are unnecessary for describing certain profile types.

![Profiles](image)

**FIGURE 9.3-6**

7.2 Selected Post-Tensioning Forces and Tendon Drape.

Columns 2 through 6 of this data block give the total post-tensioning forces and tendon heights selected by the user for tendon type A. Columns 7 and 8 are values calculated by ADAPT based on the post-tensioning selected in the preceding data block.

**Tendon A**

<table>
<thead>
<tr>
<th>Span</th>
<th>Force</th>
<th>CGS Left</th>
<th>CGS C1</th>
<th>CGS C2</th>
<th>CGS Right</th>
<th>P/A</th>
<th>Wbal</th>
<th>WBal (%DL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>425.877</td>
<td>5.00</td>
<td>---</td>
<td>1.00</td>
<td>9.00</td>
<td>197.17</td>
<td>5.396</td>
<td>120</td>
</tr>
<tr>
<td>2</td>
<td>425.877</td>
<td>9.00</td>
<td>---</td>
<td>1.00</td>
<td>9.00</td>
<td>197.17</td>
<td>3.578</td>
<td>80</td>
</tr>
<tr>
<td>3</td>
<td>425.877</td>
<td>9.00</td>
<td>---</td>
<td>1.00</td>
<td>7.25</td>
<td>197.17</td>
<td>4.545</td>
<td>101</td>
</tr>
<tr>
<td>CR</td>
<td>425.877</td>
<td>7.25</td>
<td>---</td>
<td>---</td>
<td>5.00</td>
<td>197.17</td>
<td>13.038</td>
<td>290</td>
</tr>
</tbody>
</table>

The *All Tendons* table lists the sums of the PT force, P/A and Wbal of Tendon A, Tendon B, and Tendon C selected.
During the execution of the program, ADAPT calculates the required post-tensioning forces and displays them on the screen. The execution may pause, requiring the user to confirm the prompted values or modify them. The modification of the values calculated by ADAPT and prompted on the screen is referred to as Selection of post-tensioning by the user. After user’s selection/modification of forces and drapes, the program recalculates all the parameters and stresses based on the user’s input and prompts a new set of suggested values. The important issue for a reviewer to note is that, at this stage, the user has the option to override ADAPT’s displayed values.

It is recommended that the reviewer pays particular attention in comparing the user-selected post-tensioning (as displayed in data block 7.2) with the calculated required minimum values given in data block 7.4.

Columns 3 through 5 of data block 7.2 refer to the height of the tendon’s centroid (CGS) from a user-defined reference line. The left and right locations refer to the maximum height of tendon at left and right of the span relative to this reference line. In the case of a reversed parabola, these are the heights over the centerline of supports. For simple parabolas with straight portions over the supports, the heights refer to maximum rises at left and right of the span at location of transition to a straight line. The straight portion is called the Tendon Support Width and is defined through the coefficients in data block 7.1.

P/A in column 7 is the calculated average compression at midspan, based on the user selected post-tensioning.

Wbal in column 8 is the balanced loading (normally uplift) in each span due to post-tensioning force and profile selected. It is the average uplift force over the entire span. For example, if a harped tendon is used, the balanced loading would consist of a number of concentrated loads at locations of angle change in tendon. For the purposes of illustration only, the upward forces are averaged over
the span length and the average value is entered under column 8. For the internal working of the program, however, the forces are considered at the correct locations and the correct magnitudes.

A positive value of Wbal means load acting upward against gravity. A negative value indicates a load in the direction of gravity.

7.4 Required Minimum Post-Tensioning Forces. The forces in this data block refer to the required forces at left, center, and right for the entire tributary.

<table>
<thead>
<tr>
<th>Type</th>
<th>Based on Stress Conditions</th>
<th>Based on Minimum P/A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Left</td>
<td>Center</td>
</tr>
<tr>
<td>1</td>
<td>0.00</td>
<td>49.12</td>
</tr>
<tr>
<td>2</td>
<td>117.15</td>
<td>75.52</td>
</tr>
<tr>
<td>3</td>
<td>119.88</td>
<td>73.46</td>
</tr>
<tr>
<td>CR</td>
<td>0.00</td>
<td>-----</td>
</tr>
</tbody>
</table>

The required forces determined are the net effective forces after the immediate and long-term stress losses have been deducted. From the effective forces determined by ADAPT, the post-tensioning supplier calculates the initial forces required at time of stressing of tendons.

This data block shows the post-tensioning required to meet the prime design criteria. Columns 2 through 4 are based on maintaining the tensile stresses in concrete at the location of maximum span moment, to the limit specified by the user in data block 1. Each row includes three regions for a given span. Data column 2 relates to the span’s left support region; data column 3 is for the midspan region; data column 4 shows the required force at the right support region of the same span.

For example, if the specified permissible stress for the exterior span is input as x(f’c)1/2 in data block 1, the number printed on column 3 in row of span 1 is the post-tensioning force necessary to meet that requirement.

At a given support, the post-tensioning required at the left of a support may be different from the force at its right.

The following considerations are observed in calculating the required post-tensioning in the support region:
- Stresses are calculated at 1/20th points in the span. In the region closest to the left support, the highest stress value is selected and the required post-tensioning force provided to meet this condition is printed. If user wishes to know the exact location of the highest stress, detailed reports of stresses at 1/20th points given in report Section 27 should be reviewed.

- If moments are not reduced to the face-of-support, the centerline moments are used in lieu of moments reduced to face.

- The cross-section associated with the centerline of a support is that of the slab at the support line without any contribution from the supporting structure.

If at any location the existing moments are such that no post-tensioning is required, a zero (0) will be printed at that location.

MIN P/A in column 5 through 7 are the post-tensioning forces required to provide the user-specified minimum average compression (see data block 1) in the left, right, and center regions of the span.

7.5 Service Stresses (tension shown positive). Based on the post-tensioning forces and profiles confirmed or selected by the user, the top and bottom fiber stresses are calculated for each span and printed out in this data block. The stresses refer to concrete.

<table>
<thead>
<tr>
<th>Envelope of Service 1</th>
<th>Span</th>
<th>Top Max-T</th>
<th>Top Max-C</th>
<th>Bot Max-T</th>
<th>Bot Max-C</th>
<th>Center Max-T</th>
<th>Center Max-C</th>
<th>Cenrer Max-T</th>
<th>Cenrer Max-C</th>
<th>Right Max-T</th>
<th>Right Max-C</th>
<th>Right Max-T</th>
<th>Right Max-C</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>-501.10</td>
<td>-197.03</td>
<td>-973.81</td>
<td>279.36</td>
<td>-1298.70</td>
<td>-1993.14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CR</td>
<td>-728.53</td>
<td>34.09</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Envelope of Service 2</th>
<th>Span</th>
<th>Top Max-T</th>
<th>Top Max-C</th>
<th>Bot Max-T</th>
<th>Bot Max-C</th>
<th>Center Max-T</th>
<th>Center Max-C</th>
<th>Cenrer Max-T</th>
<th>Cenrer Max-C</th>
<th>Right Max-T</th>
<th>Right Max-C</th>
<th>Right Max-T</th>
<th>Right Max-C</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>-509.34</td>
<td>-197.03</td>
<td>-1055.58</td>
<td>361.14</td>
<td>-1447.52</td>
<td>-2141.97</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CR</td>
<td>-712.45</td>
<td>18.01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Tensile stresses are shown as positive and compressive stresses as negative. Maximum tension and compression, at the top and bottom at the left and right face-of-support and midspan, are printed in their respective columns. Note that the maximum stress in a span may occur elsewhere. For the location and magnitude of
the maximum stress, refer to either the graphical display of stress distribution, or the detailed report of stresses at 1/20th point of each span.

7.6 Post-Tensioning Balance Moments, Shears and Reactions.
The post-tensioning balanced moments are moments generated in the slab as a result of post-tensioning. These are displayed in a manner similar to the moments, shears, reactions and column moments in Section 5. They refer to the total tributary.

<table>
<thead>
<tr>
<th>Span Moments and Shears</th>
<th>Span</th>
<th>Moment Left (k-ft)</th>
<th>Moment Center (k-ft)</th>
<th>Moment Right (k-ft)</th>
<th>Shear Left (k)</th>
<th>Shear Right (k)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.15</td>
<td>-16.53</td>
<td>29.09</td>
<td>-0.45</td>
<td>-0.45</td>
<td></td>
</tr>
<tr>
<td>CR</td>
<td>17.09</td>
<td>-----</td>
<td>-----</td>
<td>10.79</td>
<td>-----</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reactions and Column Moments</th>
<th>Joint</th>
<th>Reaction (k)</th>
<th>Moment Lower Column (k-ft)</th>
<th>Moment Upper Column (k-ft)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.448</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>-0.458</td>
<td>-3.888</td>
<td>0.000</td>
<td></td>
</tr>
</tbody>
</table>

Note: Moments are reported at face of support

If the reduction of moments to the face-of-support option is used in the data input (refer to data block 1), slab moments printed are those reduced to face-of-support. Otherwise, they are centerline moments. Shears, reactions and column moments are centerline values.

It is reiterated that values printed herein are due only to post-tensioning. Since post-tensioning forces are in self-equilibrium, the sum of external reactions generated by them must add up to zero. The reactions reported in this data block are the hyperstatic (secondary) actions due to post-tensioning.

9.3.4.8 Section 8: Factored Moments and Reactions Envelope

This data block lists the duly combined actions for the evaluation of the member’s ultimate strength.

8.1 Factored Design Moments (Not Redistributed). The factored and combined actions, or design actions, are the sum of dead loading, live loading and secondary effects, each multiplied by a coefficient. If reduction to face-of-support is invoked by the user, the factored moments given relate to face-of-support; else, they represent centerline moments.
8.2 Reactions and Column Moments. The factored support reactions are printed for the unit strip as defined in columns 4 through 7 of data block 2.1, and for the entire tributary in column 3 of data block 8.2. The factored support moments are given in data block 10.4.

<table>
<thead>
<tr>
<th>Joint</th>
<th>Reaction Max</th>
<th>Reaction Min</th>
<th>Moment Lower Column Max</th>
<th>Moment Lower Column Min</th>
<th>Moment Upper Column Max</th>
<th>Moment Upper Column Min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k</td>
<td>k</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>60.27</td>
<td>60.27</td>
<td>-19.21</td>
<td>-19.21</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>219.37</td>
<td>219.37</td>
<td>-7.98</td>
<td>-7.98</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3</td>
<td>235.32</td>
<td>235.32</td>
<td>-7.98</td>
<td>-7.98</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

For the design of columns, total factored reactions and factored column moments are normally used. If design handbooks are used for column design, the relating eccentricity of the axial loading commonly required for use in such handbooks is readily obtained by dividing the printed factored column moment by the corresponding total factored reaction. Shears, reactions and column moments are centerline values.

8.3 Secondary Moments. Secondary (hyperstatic) moments are caused by post-tensioning forces. These are induced in the member by the constraints of the supports to the member’s free movement. They are calculated from the secondary actions at the supports.

<table>
<thead>
<tr>
<th>Span</th>
<th>Left</th>
<th>Midspan</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>0.66</td>
<td>18.88</td>
<td>36.27</td>
</tr>
<tr>
<td>2</td>
<td>30.04</td>
<td>28.53</td>
<td>27.02</td>
</tr>
<tr>
<td>3</td>
<td>32.23</td>
<td>16.67</td>
<td>0.49</td>
</tr>
</tbody>
</table>

Note: Moments are reported at face of support

Secondary moments are adjusted to the face-of-support, provided this option is selected during input into ADAPT.

8.4 Factored Design Moments (Redistributed). These section shows moments are listed in Section 8.1 after redistribution. This section is available only if you selected to redistribute moments.
Chapter 9  REPORTS

9.3.4.9 Section 9: Factored Lateral Moments Envelope

This section shows the results for the combination of lateral and gravity moments.

9.1 Input Lateral Moments. This section mirrors the input data specified in the Lateral Input Data screen.

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>100.00</td>
<td>100.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>50.00</td>
<td>50.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

9.2 Factored Lateral Moments (Not Redistributed). This section shows factored and combined actions of dead loading, live loading, secondary effects, and lateral moments each multiplied by a coefficient.

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>+116.75</td>
<td>-83.25</td>
<td>+246.59</td>
<td>-15.64</td>
<td>-433.41</td>
<td>-67.43</td>
</tr>
<tr>
<td>2</td>
<td>-401.64</td>
<td>-131.91</td>
<td>+261.48</td>
<td>+83.47</td>
<td>-461.61</td>
<td>-168.38</td>
</tr>
<tr>
<td>3</td>
<td>-413.50</td>
<td>-215.57</td>
<td>+210.40</td>
<td>+121.33</td>
<td>-24.13</td>
<td>-13.07</td>
</tr>
</tbody>
</table>

Note: Moments are reported at face of support

9.3 Factored Lateral Moments (Redistributed). These section shows moments listed in Section 9.2 after redistribution. This section is available only if you selected to redistribute moments.

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
<th>Redist. Coef Left</th>
<th>Redist. Coef Right</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>116.61</td>
<td>-81.74</td>
<td>242.64</td>
<td>11.11</td>
<td>-350.12</td>
<td>-80.38</td>
<td>0.00</td>
<td>-20.00</td>
</tr>
<tr>
<td>2</td>
<td>-363.69</td>
<td>-106.37</td>
<td>307.05</td>
<td>139.29</td>
<td>-370.32</td>
<td>-117.21</td>
<td>13.67</td>
<td>-2.42</td>
</tr>
<tr>
<td>3</td>
<td>-370.74</td>
<td>-173.88</td>
<td>251.75</td>
<td>121.76</td>
<td>-23.49</td>
<td>-12.44</td>
<td>10.69</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Note: Moments are reported at face of support

If reduction to face-of-support is invoked by the user, the factored moments given relate to face-of-support; else, they represent centerline moments.

9.3.4.10 Section10: Mild Steel - No Redistribution

The mild reinforcement is calculated on the basis of one of the following three sets of criteria:
• One-way unbonded systems;
• Two-way unbonded systems; and
• Grouted systems.

The applicable set of criteria is invoked by the user through the choice of the structural system (one-way or two-way) and the post-tensioning system (unbonded or grouted). The user’s selection is shown clearly in data block 1.

10.1 Required Rebar. This section shows required rebar based on ultimate and minimum criteria.

<table>
<thead>
<tr>
<th>Span</th>
<th>Location</th>
<th>From</th>
<th>To</th>
<th>As Required</th>
<th>Ultimate</th>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TOP</td>
<td>0.00</td>
<td>19.17</td>
<td>3.29</td>
<td>3.29</td>
<td>0.86</td>
</tr>
<tr>
<td>3</td>
<td>TOP</td>
<td>19.34</td>
<td>22.75</td>
<td>0.29</td>
<td>0.09</td>
<td>0.29</td>
</tr>
<tr>
<td>CR</td>
<td>TOP</td>
<td>0.00</td>
<td>3.50</td>
<td>0.29</td>
<td>0.09</td>
<td>0.29</td>
</tr>
<tr>
<td>1</td>
<td>BOT</td>
<td>0.00</td>
<td>19.17</td>
<td>2.76</td>
<td>2.76</td>
<td>0.29</td>
</tr>
<tr>
<td>2</td>
<td>BOT</td>
<td>0.00</td>
<td>27.17</td>
<td>1.72</td>
<td>1.72</td>
<td>0.45</td>
</tr>
</tbody>
</table>

10.2 Provided Rebar. This section lists provided rebar details.

<table>
<thead>
<tr>
<th>Span</th>
<th>ID</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>TOP</td>
<td>0.00</td>
<td>6</td>
<td>5</td>
<td>52.00</td>
<td>1.86</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>TOP</td>
<td>17.20</td>
<td>1</td>
<td>5</td>
<td>9.50</td>
<td>0.31</td>
</tr>
<tr>
<td>CR</td>
<td>7</td>
<td>BOT</td>
<td>2.32</td>
<td>1</td>
<td>8</td>
<td>1.50</td>
<td>0.79</td>
</tr>
<tr>
<td>1</td>
<td>8</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>20.50</td>
<td>1.58</td>
</tr>
<tr>
<td>2</td>
<td>9</td>
<td>BOT</td>
<td>8.51</td>
<td>1</td>
<td>8</td>
<td>10.50</td>
<td>0.79</td>
</tr>
</tbody>
</table>

10.2.2 Total Strip Steel Disposition

<table>
<thead>
<tr>
<th>Span</th>
<th>ID</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>TOP</td>
<td>0.00</td>
<td>6</td>
<td>5</td>
<td>19.17</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>TOP</td>
<td>0.00</td>
<td>1</td>
<td>5</td>
<td>2.00</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>TOP</td>
<td>9.54</td>
<td>5</td>
<td>5</td>
<td>9.63</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>TOP</td>
<td>0.00</td>
<td>6</td>
<td>5</td>
<td>27.17</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>TOP</td>
<td>0.00</td>
<td>5</td>
<td>5</td>
<td>3.87</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>TOP</td>
<td>23.45</td>
<td>3</td>
<td>5</td>
<td>3.72</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>TOP</td>
<td>0.00</td>
<td>6</td>
<td>5</td>
<td>5.66</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>TOP</td>
<td>17.20</td>
<td>1</td>
<td>5</td>
<td>5.55</td>
</tr>
<tr>
<td>3</td>
<td>5</td>
<td>TOP</td>
<td>0.00</td>
<td>3</td>
<td>5</td>
<td>2.28</td>
</tr>
<tr>
<td>CR</td>
<td>2</td>
<td>TOP</td>
<td>0.00</td>
<td>1</td>
<td>5</td>
<td>3.95</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>19.17</td>
</tr>
<tr>
<td>1</td>
<td>8</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>19.17</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>27.17</td>
</tr>
<tr>
<td>2</td>
<td>8</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>1.33</td>
</tr>
<tr>
<td>2</td>
<td>9</td>
<td>BOT</td>
<td>8.51</td>
<td>1</td>
<td>8</td>
<td>10.50</td>
</tr>
<tr>
<td>3</td>
<td>6</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>22.75</td>
</tr>
<tr>
<td>CR</td>
<td>6</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>0.41</td>
</tr>
<tr>
<td>CR</td>
<td>7</td>
<td>BOT</td>
<td>2.32</td>
<td>1</td>
<td>8</td>
<td>1.50</td>
</tr>
</tbody>
</table>
10.3 Base Reinforcement. This section describes base reinforcement as entered by the user.

### Base Reinforcement

**Isolated bars**

<table>
<thead>
<tr>
<th>Span</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Cover</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>--</td>
<td>--</td>
<td></td>
<td>--</td>
<td>--</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>TOP</td>
<td>.00</td>
<td>5</td>
<td>5</td>
<td>1.50</td>
<td>72.59</td>
<td>1.55</td>
</tr>
</tbody>
</table>

### Mesh Reinforcement

<table>
<thead>
<tr>
<th>#</th>
<th>Span</th>
<th>Location</th>
<th>From</th>
<th>Spacing</th>
<th>Size</th>
<th>Cover</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>BOT</td>
<td>.00</td>
<td>12.00</td>
<td>4</td>
<td>1.50</td>
<td>19.17</td>
<td>3.60</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>BOT</td>
<td>.00</td>
<td>12.00</td>
<td>4</td>
<td>1.50</td>
<td>27.17</td>
<td>3.60</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>BOT</td>
<td>.00</td>
<td>12.00</td>
<td>4</td>
<td>1.50</td>
<td>22.75</td>
<td>3.60</td>
</tr>
<tr>
<td></td>
<td>CR</td>
<td>BOT</td>
<td>.00</td>
<td>12.00</td>
<td>4</td>
<td>1.50</td>
<td>3.50</td>
<td>3.60</td>
</tr>
</tbody>
</table>

9.3.4.11 Section 11: Mild Steel – Redistributed

This section is the same as Section 10. The only difference is that the values for reinforcement are based on the redistributed moments.

9.3.4.12 Section 12: Shear Reinforcement

Depending on the structural system selected, either a punching shear check (two-way systems) or a one-way shear check (one-way systems) is conducted.

A one-way shear check is conducted for BEAMS and ONE-WAY SLABS.

12.1 Shear Calculation Envelope. Each span is subdivided into 20 equal parts. Shear is checked at each subdivision.

### SPAN 1

<table>
<thead>
<tr>
<th>XL</th>
<th>X</th>
<th>d</th>
<th>Vu</th>
<th>Mu</th>
<th>Ratio</th>
<th>Req.</th>
<th>Spacing</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ft</td>
<td>in</td>
<td>k</td>
<td>kft</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>31.69</td>
<td>-87.92</td>
<td>-102.18</td>
<td>0.57</td>
<td>0.05</td>
<td>23.62</td>
</tr>
<tr>
<td>0.05</td>
<td>3.20</td>
<td>30.50</td>
<td>-77.86</td>
<td>163.08</td>
<td>0.53</td>
<td>0.05</td>
<td>23.62</td>
</tr>
<tr>
<td>0.10</td>
<td>6.40</td>
<td>30.50</td>
<td>-67.80</td>
<td>396.16</td>
<td>0.80</td>
<td>0.05</td>
<td>23.62</td>
</tr>
<tr>
<td>0.15</td>
<td>9.60</td>
<td>30.50</td>
<td>-57.74</td>
<td>597.04</td>
<td>0.88</td>
<td>0.05</td>
<td>23.62</td>
</tr>
<tr>
<td>0.20</td>
<td>12.80</td>
<td>30.50</td>
<td>-47.66</td>
<td>765.59</td>
<td>0.81</td>
<td>0.05</td>
<td>23.62</td>
</tr>
<tr>
<td>0.25</td>
<td>16.00</td>
<td>30.50</td>
<td>-37.62</td>
<td>902.17</td>
<td>0.64</td>
<td>0.05</td>
<td>23.62</td>
</tr>
<tr>
<td>0.30</td>
<td>19.20</td>
<td>30.50</td>
<td>-27.57</td>
<td>1006.27</td>
<td>0.47</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.35</td>
<td>22.40</td>
<td>30.50</td>
<td>-17.49</td>
<td>1078.62</td>
<td>0.30</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.40</td>
<td>25.60</td>
<td>30.50</td>
<td>-7.43</td>
<td>1118.49</td>
<td>0.13</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.45</td>
<td>28.80</td>
<td>30.50</td>
<td>2.64</td>
<td>1125.87</td>
<td>0.04</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.50</td>
<td>32.00</td>
<td>30.50</td>
<td>12.68</td>
<td>1101.51</td>
<td>0.21</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.55</td>
<td>35.20</td>
<td>30.50</td>
<td>22.75</td>
<td>1044.66</td>
<td>0.39</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.60</td>
<td>38.39</td>
<td>30.50</td>
<td>32.81</td>
<td>956.07</td>
<td>0.56</td>
<td>0.05</td>
<td>23.62</td>
</tr>
<tr>
<td>0.65</td>
<td>41.60</td>
<td>30.50</td>
<td>42.87</td>
<td>834.99</td>
<td>0.73</td>
<td>0.05</td>
<td>23.62</td>
</tr>
</tbody>
</table>
The depth d used for stirrup calculations is based on the total depth of the section and reinforcement cover.

9.3.4.13 Section 13: Punching Shear Reinforcement

A punching shear check is carried out if the structural system is TWO-WAY.

### 13.1 Critical Section Geometry.

<table>
<thead>
<tr>
<th>Column</th>
<th>Layer</th>
<th>Cond.</th>
<th>a</th>
<th>d</th>
<th>b1</th>
<th>b2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>1</td>
<td>4.69</td>
<td>9.38</td>
<td>52.37</td>
<td>45.37</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>1</td>
<td>8.19</td>
<td>16.38</td>
<td>28.84</td>
<td>28.84</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>1</td>
<td>7.19</td>
<td>14.38</td>
<td>28.38</td>
<td>30.37</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>1</td>
<td>4.44</td>
<td>8.88</td>
<td>38.87</td>
<td>56.87</td>
</tr>
</tbody>
</table>

Layer: The layer of the reinforcement for each column
Cond.: 1 = Interior, 2 = End, 3 = Corner, 4 = Edge
a: The distance between the layer and face of column or drop cap(*)
d: Effective depth
b1: length of section parallel to span line
b2: length of section normal to span line

### 13.2 Critical Section Stresses. The outcome of the punching shear analysis is summarized in data column entitled Stress ratio. This is the punching stress calculated divided by the allowable stress. If the stress ratio for any support exceeds limits imposed by the code the cross section has to be enlarged, or punching shear reinforcement provided.

<table>
<thead>
<tr>
<th>Label</th>
<th>Layer</th>
<th>Cond.</th>
<th>Factored shear</th>
<th>Factored moment</th>
<th>Stress due to shear</th>
<th>Stress due to moment</th>
<th>Total stress</th>
<th>Allowable stress</th>
<th>Stress ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>k</td>
<td>k-ft</td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
<td></td>
</tr>
</tbody>
</table>
Four location conditions, such as corner column, edge columns, etc., are differentiated in the punching shear calculations. These conditions are clearly displayed at the top of this data block. From the geometry of the problem inputted by the user, ADAPT determines which of the conditions is applicable at each support. The condition as identified by ADAPT is listed in data column 3.

If ADAPT determines that a punching shear check is not applicable for a support, such as in the case of a wall support, no values will be printed for that joint.

Data columns 4 and 5 are the applicable FACTORED shear and moment at the joints. Calculated stresses due to the factored shears and moments are shown in data columns 6 and 7. The hypothetical punching perimeter to which these stresses refer is indicated by the case number in data column 10.

TOTAL stress (column 7) is the sum of stresses due to shear and bending (sum of columns 5 and 6).

The average post-tensioning substituted in the relationship is the post-tensioning of the current problem. The contribution of the tendon slope in increasing the allowable stress is conservatively omitted. In the calculation of permissible stresses, the corner, exterior and interior columns are treated in the same manner.

13.3 Punching Shear Reinforcement. This section lists required punching shear reinforcement.

Reinforcement option: Shear Studs
Stud diameter: 0.38
Number of rails per side: 1

<table>
<thead>
<tr>
<th>Col.</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1.6</td>
<td>3.3</td>
<td>4.9</td>
<td>6.5</td>
<td>8.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1.0</td>
<td>2.1</td>
<td>3.1</td>
<td>4.1</td>
<td>5.1</td>
<td>6.2</td>
<td>7.2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Dist. = Distance measured from the face of support
Note: Columns with --- have not been checked for punching shear.
Note: Columns with *** have exceeded the maximum allowable shear stress.
9.3.4.14 Section 14: Deflections

The deflection data block in the report is a summary of the calculations showing only the maximum values obtained for each span.

### 14.1 Maximum Span Deflections

<table>
<thead>
<tr>
<th>Span</th>
<th>SW</th>
<th>SW+PT</th>
<th>SW+PT+SDL</th>
<th>SW+PT+SDL+Creep</th>
<th>LL</th>
<th>X</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>0.03</td>
<td>-0.06</td>
<td>-0.02</td>
<td>-0.06(3928)</td>
<td>0.03(6923)</td>
<td>0.00(****)</td>
<td>0.06(4021)</td>
</tr>
<tr>
<td>2</td>
<td>0.06</td>
<td>-0.03</td>
<td>0.10</td>
<td>0.29(1108)</td>
<td>0.04(8002)</td>
<td>0.00(****)</td>
<td>0.33(975)</td>
</tr>
<tr>
<td>3</td>
<td>0.07</td>
<td>-0.04</td>
<td>0.09</td>
<td>0.28(966)</td>
<td>0.06(4421)</td>
<td>0.00(****)</td>
<td>0.34(797)</td>
</tr>
<tr>
<td>CR</td>
<td>-0.04</td>
<td>0.00</td>
<td>-0.08</td>
<td>-0.23(184)</td>
<td>-0.03(1234)</td>
<td>0.00(****)</td>
<td>-0.26(160)</td>
</tr>
</tbody>
</table>

The concrete’s modulus of elasticity \( (E_c) \) used for the deflection is calculated by ADAPT using the concrete strength input by the user and the selected code’s formula for normal-weight and lightweight concrete. The user has the option to overwrite the code-based modulus of elasticity and enter his/her choice.

The Creep factor \( (K) \) is input by the user. It is the number by which the deflection due to dead load and post-tensioning is multiplied to obtain the additional time-dependent deflection.

A negative deflection value indicates deflection upward.

Values in the parentheses are the deflection ratios computed as the length of each span divided by its maximum deflection. Deflection ratios are entered as positive regardless of direction of deflection. If a deflection ratio exceeds 100000, a value equal to 99999 is entered within the parentheses.

Data column 2 (SW) is deflection due only to self-weight. It should be noted that this column of data serves only as background information for the user, for at no time during its function is the slab expected to be subjected to self-weight alone. Under normal conditions either post-tensioning or shoring will be present.

SW+PT in column 3 is the immediate elastic deflection of the slab due to the self-weight and the post-tensioning.

SW+PT+SDL in column 4 is the immediate elastic deflection of the slab due to the self-weight, user-defined dead loading and the post-tensioning.
SW+PT+SDL+CREEP in column 5 is the sum of the immediate deflection (column 3) and the deflection due to creep. The deflection due to creep is not applied to the live loading. This column is \((1+K)\) times the deflection due to SW+PT+SDL (column 4).

Deflection due to live loading (LL) is listed in column 6.

Finally, the long-term deflection due to dead load, post-tensioning and the immediate live-load deflection are totaled in the last column (column 7).

9.3.4.15 Section 15: Friction, Elongation and Long-Term Stresses

15.1 Input Parameters. This section shows the values entered during data entry.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Strand</td>
<td>Low Relaxation</td>
<td>Coefficient of Angular Friction</td>
<td>0.07000 1/rad</td>
</tr>
<tr>
<td>Coefficient of Wobble Friction</td>
<td>0.00050 rad/m</td>
<td>Ec at Stressing</td>
<td>10500.00 MPa</td>
</tr>
<tr>
<td>Anchor Set</td>
<td>6.00 mm</td>
<td>Ratio of Jacking Stress</td>
<td>0.90</td>
</tr>
<tr>
<td>Average Relative Humidity</td>
<td>80.00 percent</td>
<td>Anchor Set</td>
<td>6.00 mm</td>
</tr>
<tr>
<td>Average of Surface Ratio of Members</td>
<td>130.00 mm</td>
<td>Tendon_A Stressing Method</td>
<td>Both side</td>
</tr>
<tr>
<td>Vol of Strand</td>
<td>190000.00 MPa</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

15.2 Long-term Losses. This section can report different information depending on the option that the user selected for the long-term stress loss calculation. There are three options for long-term stress loss calculations:

- **Lump sum entry.** A lump sum value may be calculated by the user and entered during data input. The effective stresses in the tendon are calculated by subtracting this value from the initial stresses. Since the friction and seating losses cause the initial stresses to vary along the tendon, the effective stresses will also vary. The lump sum is reported in the Section 15.1 Input parameters. In this case the section 15.2 is not reported.

- **Long-Term Loss calculations for unbonded tendons.** For unbonded tendons, the strain in the tendon at any given point is not directly related to the local strain in the concrete. The program can calculate and report an average long-term loss value for the entire tendon based on the average precompression in the member and expected losses due to shrinkage, creep, elastic...
shortening and relaxation of the prestressing steel. The effective stresses in the tendon are calculated by subtracting the average long-term loss value from the initial stresses. To obtain these results the user has to execute ADAPT in Force Selection mode. The section table will show as follows:

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Elastic Shortening</th>
<th>Shrinkage</th>
<th>Creep</th>
<th>Relaxation</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MPa</td>
<td>MPa</td>
<td>MPa</td>
<td>MPa</td>
<td>MPa</td>
</tr>
<tr>
<td>TENDON_A</td>
<td>28.52</td>
<td>17.28</td>
<td>34.96</td>
<td>42.49</td>
<td>123.20</td>
</tr>
</tbody>
</table>

- Long-Term Loss computation for grouted tendons. Long-term stress losses in grouted tendons are a function of the local strain in the concrete. In order to calculate long-term stress loss for a grouted system, a detailed strain computations must be done along the path of tendon. Detail listing of stresses of long-term losses is available if ADAPT is executed in Tendon Selection mode. In this case the values at left, center and right of each span are listed as shown in the following table:

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Span</th>
<th>Left</th>
<th>Center</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>TENDON_A</td>
<td>CL</td>
<td>7.29</td>
<td>7.57</td>
<td>8.16</td>
</tr>
<tr>
<td>TENDON_A</td>
<td>1</td>
<td>8.26</td>
<td>8.87</td>
<td>9.46</td>
</tr>
<tr>
<td>TENDON_A</td>
<td>2</td>
<td>9.58</td>
<td>9.05</td>
<td>9.03</td>
</tr>
</tbody>
</table>

ADAPT calculates the losses at 1/20th points along each span and lists them in a file for interested users (friction_detail.dat). This is a text file and can be viewed with any text editor or word processor.

If a friction and long-term losses calculation need to be done for a grouted system designed with Force Selection, a lump sum must be entered for long-term loss.

15.3 Calculated Stresses After Friction and Long-Term Losses. Shows calculated stresses after friction and long-term loss at left, center and right of span.

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Span</th>
<th>Stress Left Only</th>
<th>Stress Center FL Only</th>
<th>Stress Right FL Only</th>
<th>Stress Left FL+LTL</th>
<th>Stress Center FL+LTL</th>
<th>Stress Right FL+LTL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
</tr>
<tr>
<td>TENDON_A</td>
<td>1</td>
<td>215.59</td>
<td>218.49</td>
<td>224.01</td>
<td>203.97</td>
<td>206.88</td>
<td>212.54</td>
</tr>
<tr>
<td>TENDON_A</td>
<td>2</td>
<td>224.01</td>
<td>225.32</td>
<td>220.53</td>
<td>212.54</td>
<td>213.70</td>
<td>208.91</td>
</tr>
<tr>
<td>TENDON_A</td>
<td>3</td>
<td>220.53</td>
<td>213.85</td>
<td>210.36</td>
<td>208.91</td>
<td>202.23</td>
<td>198.75</td>
</tr>
</tbody>
</table>

15.4 Summary. Gives the average initial stress, the total long-term losses, the final average stress, and the final average force. The
section shows the left, right and total elongation after anchor set. It also gives the left and right anchor set influence distances.

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Avg. Initial Stress</th>
<th>Avg. Final Stress</th>
<th>Avg. Final Force</th>
<th>Elongation Left</th>
<th>Elongation Right</th>
<th>Elongation Total</th>
<th>Left Anchor Set</th>
<th>Right Anchor Set</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ksi</td>
<td>ksi</td>
<td>k</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>ft</td>
<td>ft</td>
</tr>
<tr>
<td>TENDON_A</td>
<td>219.45</td>
<td>11.60</td>
<td>207.85</td>
<td>31.89</td>
<td>5.80</td>
<td>-0.06</td>
<td>5.74</td>
<td>28.00</td>
</tr>
</tbody>
</table>

**15.5 Critical Stress Ratios.** The Critical Stress Ratios shows the ratios of the stresses to the strand’s specified ultimate strength.

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Stressing Left</th>
<th>Stressing Right</th>
<th>Anchorage Left</th>
<th>Anchorage Right</th>
<th>Max Stress Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>TENDON_A</td>
<td>0.90</td>
<td>0.90</td>
<td>0.80</td>
<td>0.78</td>
<td>0.84</td>
</tr>
</tbody>
</table>

**15.6 Summary.** It gives average force per span, tendon extends, elongation left and right of span, anchor set left and right of span, stress at anchorage and maximum stress along tendon. Data block is for tendon selection and data.

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Force</th>
<th>Ext. Left</th>
<th>Start Span</th>
<th>End Span</th>
<th>Ext. Right</th>
<th>Elong. Left</th>
<th>Elong Right</th>
<th>Anchor Left</th>
<th>Anchor Right</th>
<th>Max Stress Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k</td>
<td>in</td>
<td>in</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TENDON_A</td>
<td>33.58</td>
<td>0.00</td>
<td>1</td>
<td>3</td>
<td>0.00</td>
<td>5.80</td>
<td>-0.06</td>
<td>0.80</td>
<td>0.78</td>
<td>0.84</td>
</tr>
<tr>
<td>TENDON_B</td>
<td>33.63</td>
<td>0.00</td>
<td>1</td>
<td>1</td>
<td>0.20</td>
<td>2.68</td>
<td>0.00</td>
<td>0.80</td>
<td>0.84</td>
<td>0.84</td>
</tr>
<tr>
<td>TENDON_C</td>
<td>32.83</td>
<td>0.20</td>
<td>3</td>
<td>3</td>
<td>0.00</td>
<td>0.00</td>
<td>2.16</td>
<td>0.83</td>
<td>0.78</td>
<td>0.83</td>
</tr>
</tbody>
</table>

**Tendon** column lists the types of tendons used. These may be tendons A, B and C.

**Force** is the average force in each strand along the length of each tendon. The average force is not used in the computations. It is listed as an indicator, since this force is viewed by some engineers as a measure of effectiveness of a strand when comparing alternatives.

**Ext. Left** and **Ext. Right** illustrate the extent of each tendon type into left and right spas.

**Elong. Left** and **Elong. Right** are the elongations at left and right of each tendon. If a tendon type is stressed at one end only, the elongation at the dead end will be shown by a zero in the report.

**Anchor Left** and **Anchor Right** is the stress after seating loss at anchorage divided by the strand’s ultimate strength.
Max. Stress Ratio is the ratio of the maximum stress along each tendon to the strand’s ultimate strength immediately after jacking and seating of tendon.

Description of Output; Type A, Type B, and Type C

- A solution for a grouted system in effective-force mode with lump sum stress specification (TYPE B);
- A solution for an unbonded tendon system in effective-force mode, together with computed long-term stress losses (TYPE A); and,
- A solution for a grouted system in tendon-selection mode with computed long-term stress loss (TYPE C). An unbonded tendon system with tendon-selection mode and computed long-term loss calculations also has a report type (C) as indicated in the flow chart.
Type A

15 - FRICTION, ELONGATION AND LONG-TERM LOSSES

### 15.1 Input Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Strand</td>
<td>Low Relaxation</td>
</tr>
<tr>
<td>Age of Concrete at Stressing</td>
<td>5 days</td>
</tr>
<tr>
<td>Ec at Stressing</td>
<td>1523.00 ksi</td>
</tr>
<tr>
<td>Average Relative Humidity</td>
<td>80.00 percent</td>
</tr>
<tr>
<td>Volume to Surface Ratio of Members</td>
<td>0.00 in</td>
</tr>
<tr>
<td>Es of Strand</td>
<td>29000.00 ksi</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coefficient of Angular Friction (meu)</td>
<td>0.07000 1/rad</td>
</tr>
<tr>
<td>Coefficient of Wobble Friction (K)</td>
<td>0.00140 rad/ft</td>
</tr>
<tr>
<td>Ratio of Jacking Stress</td>
<td>0.80</td>
</tr>
<tr>
<td>Anchor Set</td>
<td>0.25 in</td>
</tr>
<tr>
<td>Tendon_A Stressing Method</td>
<td>Both sides</td>
</tr>
</tbody>
</table>

### 15.2 Long-term Losses

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Elastic Shortening</th>
<th>Shrinkage</th>
<th>Creep</th>
<th>Relaxation</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>TENDON A</td>
<td>1.19</td>
<td>4.04</td>
<td>1.61</td>
<td>3.54</td>
<td>10.48</td>
</tr>
</tbody>
</table>

### 15.3 Calculated Stresses After Friction and Long-term Losses

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Span</th>
<th>Stress Left FL Only</th>
<th>Stress Center FL Only</th>
<th>Stress Right FL Only</th>
<th>Stress Left FL+LTL</th>
<th>Stress Center FL+LTL</th>
<th>Stress Right FL+LTL</th>
</tr>
</thead>
<tbody>
<tr>
<td>TENDON A</td>
<td>1</td>
<td>177.67</td>
<td>182.56</td>
<td>189.66</td>
<td>167.19</td>
<td>172.08</td>
<td>179.18</td>
</tr>
<tr>
<td>TENDON A</td>
<td>2</td>
<td>190.64</td>
<td>196.29</td>
<td>190.93</td>
<td>180.16</td>
<td>185.81</td>
<td>180.45</td>
</tr>
<tr>
<td>TENDON A</td>
<td>3</td>
<td>189.97</td>
<td>183.44</td>
<td>176.94</td>
<td>179.49</td>
<td>172.96</td>
<td>166.46</td>
</tr>
<tr>
<td>TENDON A</td>
<td>CR</td>
<td>176.47</td>
<td>173.32</td>
<td>170.50</td>
<td>165.99</td>
<td>162.84</td>
<td>160.02</td>
</tr>
</tbody>
</table>

### 15.4 Summary

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Avg. Initial Stress</th>
<th>LTL</th>
<th>Avg. Final Stress</th>
<th>Avg. Final Force</th>
<th>Elongation Left</th>
<th>Elongation Right</th>
<th>Elongation Total</th>
<th>Left Anchor Set</th>
<th>Right Anchor Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>TENDON A</td>
<td>183.20</td>
<td>10.48</td>
<td>172.72</td>
<td>26.94</td>
<td>5.59</td>
<td>0.00</td>
<td>5.59</td>
<td>32.03</td>
<td>32.5</td>
</tr>
</tbody>
</table>

### 15.5 Critical Stress Ratios

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Stressing Left</th>
<th>Stressing Right</th>
<th>Anchorage Left</th>
<th>Anchorage Right</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>TENDON A</td>
<td>0.80</td>
<td>0.80</td>
<td>0.66</td>
<td>0.64</td>
<td>0.73</td>
</tr>
</tbody>
</table>
Type B

15 - FRICTION, ELONGATION AND LONG-TERM LOSSES

15.1 Input Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long term Lump Loss</td>
<td>1.16 ksi</td>
<td>Ratio of Jacking Stress</td>
<td>0.80</td>
</tr>
<tr>
<td>Es of Strand</td>
<td>29000.00 ksi</td>
<td>Anchor Set</td>
<td>0.25 in</td>
</tr>
<tr>
<td>Coefficient of Angular Friction (m)</td>
<td>0.07000 1/rad</td>
<td>Tendon_A Stressing Method</td>
<td>Both sides</td>
</tr>
<tr>
<td>Coefficient of Wobble Friction (K)</td>
<td>0.00140 rad/ft</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

15.3 Calculated Stresses After Friction and Long-term Losses

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Span</th>
<th>Stress Left FL Only</th>
<th>Stress Center FL Only</th>
<th>Stress Right FL Only</th>
<th>Stress Left FL+LTL</th>
<th>Stress Center FL+LTL</th>
<th>Stress Right FL+LTL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
</tr>
<tr>
<td>TENDON A</td>
<td>1</td>
<td>178.42</td>
<td>183.36</td>
<td>190.47</td>
<td>177.26</td>
<td>182.20</td>
<td>189.31</td>
</tr>
<tr>
<td>TENDON A</td>
<td>2</td>
<td>190.47</td>
<td>197.01</td>
<td>190.91</td>
<td>189.31</td>
<td>195.84</td>
<td>189.75</td>
</tr>
<tr>
<td>TENDON A</td>
<td>3</td>
<td>190.91</td>
<td>184.38</td>
<td>175.52</td>
<td>189.75</td>
<td>183.21</td>
<td>174.36</td>
</tr>
<tr>
<td>TENDON A</td>
<td>CR</td>
<td>175.52</td>
<td>173.78</td>
<td>172.18</td>
<td>174.36</td>
<td>172.62</td>
<td>171.02</td>
</tr>
</tbody>
</table>

15.4 Summary

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Avg. Initial Stress</th>
<th>LTL</th>
<th>Avg. Final Stress</th>
<th>Avg. Final Force</th>
<th>Elongation Left</th>
<th>Elongation Right</th>
<th>Elongation Total</th>
<th>Left Anchor Set</th>
<th>Right Anchor Set</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
<td>k</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>ft</td>
<td>ft</td>
</tr>
<tr>
<td>TENDON A</td>
<td>184.00</td>
<td>1.16</td>
<td>182.84</td>
<td>27.98</td>
<td>5.65</td>
<td>-0.01</td>
<td>5.64</td>
<td>32.76</td>
<td>39.83</td>
</tr>
</tbody>
</table>

15.5 Critical Stress Ratios

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Stressing Left</th>
<th>Stressing Right</th>
<th>Anchorage Left</th>
<th>Anchorage Right</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>TENDON A</td>
<td>0.80</td>
<td>0.80</td>
<td>0.66</td>
<td>0.64</td>
<td>0.73</td>
</tr>
</tbody>
</table>
Chapter 9

REPORTS

Type C

15 - FRICTION, ELONGATION AND LONG-TERM LOSSES

15.1 Input Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Strand</td>
<td>Low Relaxation</td>
<td>Coefficient of Wobble Friction (K)</td>
<td>0.00140 rad/ft</td>
</tr>
<tr>
<td>Age of Concrete at Stressing</td>
<td>5 days</td>
<td>Ratio of Jacking Stress</td>
<td>0.80</td>
</tr>
<tr>
<td>Ec at Stressing</td>
<td>1523.00 ksi</td>
<td>Anchor Set</td>
<td>0.25 in</td>
</tr>
<tr>
<td>Average Relative Humidity</td>
<td>80.00 percent</td>
<td>Tendon A Stressing Method</td>
<td>Both sides</td>
</tr>
<tr>
<td>Volume to Surface Ratio of Members</td>
<td>0.00 in</td>
<td>Tendon B Stressing Method</td>
<td>Left side</td>
</tr>
<tr>
<td>Es of Strand</td>
<td>29000.00 ksi</td>
<td>Tendon C Stressing Method</td>
<td>Right side</td>
</tr>
<tr>
<td>Coefficient of Angular Friction (meu)</td>
<td>0.07000 1/rad</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

15.2 Long-term Losses

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Span</th>
<th>Left</th>
<th>Center</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ksi</td>
<td>ksi</td>
<td>ksi</td>
<td></td>
</tr>
<tr>
<td>TENDON A 1</td>
<td>7.92</td>
<td>10.17</td>
<td>10.97</td>
<td></td>
</tr>
<tr>
<td>TENDON A 2</td>
<td>10.90</td>
<td>11.20</td>
<td>10.89</td>
<td></td>
</tr>
<tr>
<td>TENDON A 3</td>
<td>10.95</td>
<td>10.45</td>
<td>8.77</td>
<td></td>
</tr>
<tr>
<td>TENDON A CR</td>
<td>9.26</td>
<td>7.65</td>
<td>7.30</td>
<td></td>
</tr>
<tr>
<td>TENDON B 1</td>
<td>7.73</td>
<td>10.17</td>
<td>10.85</td>
<td></td>
</tr>
<tr>
<td>TENDON B 2</td>
<td>10.86</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>TENDON B 3</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>TENDON B CR</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>TENDON C 1</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>TENDON C 2</td>
<td>0.00</td>
<td>0.00</td>
<td>10.84</td>
<td></td>
</tr>
<tr>
<td>TENDON C 3</td>
<td>10.95</td>
<td>10.45</td>
<td>8.77</td>
<td></td>
</tr>
<tr>
<td>TENDON C CR</td>
<td>9.26</td>
<td>7.65</td>
<td>7.30</td>
<td></td>
</tr>
</tbody>
</table>

15.3 Calculated Stresses After Friction and Long-term Losses

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Span</th>
<th>Stress Left FL Only ksi</th>
<th>Stress Center FL Only ksi</th>
<th>Stress Right FL Only ksi</th>
<th>Stress Left FL+LTL ksi</th>
<th>Stress Center FL+LTL ksi</th>
<th>Stress Right FL+LTL ksi</th>
</tr>
</thead>
<tbody>
<tr>
<td>TENDON A 1</td>
<td>178.42</td>
<td>183.36</td>
<td>190.47</td>
<td>170.44</td>
<td>173.20</td>
<td>179.44</td>
<td></td>
</tr>
<tr>
<td>TENDON A 2</td>
<td>190.47</td>
<td>197.01</td>
<td>190.91</td>
<td>179.58</td>
<td>185.83</td>
<td>180.02</td>
<td></td>
</tr>
<tr>
<td>TENDON A 3</td>
<td>190.91</td>
<td>184.38</td>
<td>175.52</td>
<td>180.02</td>
<td>173.92</td>
<td>166.95</td>
<td></td>
</tr>
<tr>
<td>TENDON A CR</td>
<td>175.52</td>
<td>173.78</td>
<td>172.18</td>
<td>166.23</td>
<td>166.06</td>
<td>164.78</td>
<td></td>
</tr>
<tr>
<td>TENDON B 1</td>
<td>177.12</td>
<td>182.05</td>
<td>189.17</td>
<td>169.42</td>
<td>171.89</td>
<td>178.28</td>
<td></td>
</tr>
<tr>
<td>TENDON B 2</td>
<td>189.17</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>TENDON B 3</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>TENDON B CR</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>TENDON C 1</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>TENDON C 2</td>
<td>0.00</td>
<td>0.00</td>
<td>191.05</td>
<td>0.00</td>
<td>0.00</td>
<td>180.17</td>
<td></td>
</tr>
<tr>
<td>TENDON C 3</td>
<td>191.05</td>
<td>184.38</td>
<td>175.52</td>
<td>180.17</td>
<td>173.92</td>
<td>166.95</td>
<td></td>
</tr>
<tr>
<td>TENDON C CR</td>
<td>175.52</td>
<td>173.78</td>
<td>172.18</td>
<td>166.23</td>
<td>166.06</td>
<td>164.78</td>
<td></td>
</tr>
</tbody>
</table>

15.6 Summary

<table>
<thead>
<tr>
<th>Tendon</th>
<th>Force k</th>
<th>Ext. Left</th>
<th>Start Span</th>
<th>End Span</th>
<th>Ext. Right</th>
<th>Elong. Left</th>
<th>Elong Right</th>
<th>Anchor Left</th>
<th>Anchor Right</th>
<th>Max Stress ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>TENDON A</td>
<td>28.15</td>
<td>0.00</td>
<td>1 CR</td>
<td>0.00</td>
<td>5.65</td>
<td>-0.01</td>
<td>0.66</td>
<td>0.64</td>
<td>0.73</td>
<td></td>
</tr>
<tr>
<td>TENDON B</td>
<td>28.13</td>
<td>0.00</td>
<td>1</td>
<td>1</td>
<td>0.20</td>
<td>1.68</td>
<td>0.00</td>
<td>0.66</td>
<td>0.71</td>
<td>0.71</td>
</tr>
<tr>
<td>TENDON C</td>
<td>27.58</td>
<td>0.20</td>
<td>3 CR</td>
<td>0.00</td>
<td>0.00</td>
<td>2.43</td>
<td>0.72</td>
<td>0.64</td>
<td>0.72</td>
<td></td>
</tr>
</tbody>
</table>
9.3.5 Detailed Report

The detailed report consists of listing of values at 1/20th points along each span. As an example, the following illustrates partial listings of moments, stresses, post-tensioning losses and final stress, and tendon heights. Selected detailed results of the analysis and design at 1/20th points along each span may be appended to the comprehensive output using the report setup dialog box. Detailed output for some of the results are available after completion of the run, while others are only available after successful execution of one of the program’s post-processors. All of the detailed output files are written to separate data files with the .DAT extension, and may also be appended to the tabulated output. Examples of each output are provided at the end of this section.

9.3.5.1 Section 21: Tendon Heights

The detailed tendon height output reports the height of the centroid of tendon at 1/20th points along each span. The data is stored in the PTCGS.DAT file for the interested user. The regular ADAPT report gives only the type of tendon profile and its CGS (centroid of tendon), high and low points, as well as distances to inflection points, if applicable. This means three horizontal and three vertical distances.

<table>
<thead>
<tr>
<th>X</th>
<th>CGS A</th>
<th>CGS B</th>
<th>CGS C</th>
<th>X</th>
<th>CGS A</th>
<th>CGS B</th>
<th>CGS C</th>
</tr>
</thead>
<tbody>
<tr>
<td>ft</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>ft</td>
<td>in</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>SPAN 1</td>
<td></td>
<td></td>
<td></td>
<td>SPAN 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>-3.56</td>
<td>-3.56</td>
<td>-3.56</td>
<td>0.00</td>
<td>9.00</td>
<td>9.00</td>
</tr>
<tr>
<td>0.05</td>
<td>0.96</td>
<td>-3.56</td>
<td>-3.56</td>
<td>-3.56</td>
<td>1.36</td>
<td>9.00</td>
<td>9.00</td>
</tr>
<tr>
<td>0.10</td>
<td>1.92</td>
<td>-4.86</td>
<td>-4.86</td>
<td>-4.86</td>
<td>2.72</td>
<td>5.57</td>
<td>5.57</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>1.00</td>
<td>19.17</td>
<td>9.00</td>
<td>9.00</td>
<td>9.00</td>
<td>27.17</td>
<td>9.00</td>
<td>9.00</td>
</tr>
</tbody>
</table>

The tendon height option is of particular interest to post-tensioning suppliers and others who either prepare or review shop drawings.

9.3.5.2 Section 22: Post-tensioning Balanced Loading

After completion of a run, this option lists the equivalent loading generated to substitute the post-tensioning obtained in ADAPT’s final design. The listing of Balanced Loading or Equivalent Loading can be used as an applied loading in an independent general frame program to verify the accuracy of ADAPT post-tensioning solutions.
### 9.3.5.3 Section 23: Detailed Moments

This section shows a detailed listing at 1/20th points in each span for moments.

<table>
<thead>
<tr>
<th>Span</th>
<th>Type</th>
<th>W</th>
<th>F</th>
<th>M</th>
<th>a</th>
<th>b</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>k/ft</td>
<td>k</td>
<td>k-ft</td>
<td>ft</td>
<td>ft</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>66.58</td>
<td>0.96</td>
<td>9.59</td>
<td>17.64</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>-7.718</td>
<td>0.96</td>
<td>9.59</td>
<td>17.64</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>-26.830</td>
<td>0.96</td>
<td>9.59</td>
<td>17.64</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>216.02</td>
<td>17.64</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>-17.329</td>
<td>13.59</td>
<td>25.27</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>202.46</td>
<td>25.27</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>220.46</td>
<td>1.59</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>-22.536</td>
<td>11.38</td>
<td>21.16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>-12.116</td>
<td>11.38</td>
<td>21.16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>118.53</td>
<td>21.16</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CR</td>
<td>3</td>
<td>-13.691</td>
<td>0.00</td>
<td>3.50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CR</td>
<td>2</td>
<td>47.92</td>
<td>0.00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 9.3.5.4 Section 24: Detailed Shears

This section shows a detailed listing at 1/20th points in each span for shears.

<table>
<thead>
<tr>
<th>Span</th>
<th>XL</th>
<th>X</th>
<th>SW</th>
<th>SDL</th>
<th>XL</th>
<th>LL Min</th>
<th>LL Max</th>
<th>PT</th>
<th>Secondary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td></td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>0.05</td>
<td>0.96</td>
<td>0.00</td>
<td>26.97</td>
<td>0.00</td>
<td>13.63</td>
<td>13.63</td>
<td>0.76</td>
<td>0.76</td>
<td></td>
</tr>
<tr>
<td>0.10</td>
<td>1.92</td>
<td>0.00</td>
<td>49.81</td>
<td>0.00</td>
<td>25.27</td>
<td>25.27</td>
<td>-58.75</td>
<td>1.52</td>
<td></td>
</tr>
<tr>
<td>0.15</td>
<td>2.88</td>
<td>0.00</td>
<td>68.52</td>
<td>0.00</td>
<td>34.92</td>
<td>34.92</td>
<td>-111.17</td>
<td>2.28</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90</td>
<td>17.25</td>
<td>0.00</td>
<td>-147.01</td>
<td>0.00</td>
<td>-58.35</td>
<td>-58.35</td>
<td>515.29</td>
<td>13.70</td>
<td></td>
</tr>
<tr>
<td>0.95</td>
<td>18.21</td>
<td>0.00</td>
<td>-194.45</td>
<td>0.00</td>
<td>-80.44</td>
<td>-80.44</td>
<td>596.90</td>
<td>14.46</td>
<td></td>
</tr>
<tr>
<td>1.00</td>
<td>19.17</td>
<td>0.00</td>
<td>-246.03</td>
<td>0.00</td>
<td>-104.52</td>
<td>-104.52</td>
<td>597.66</td>
<td>15.23</td>
<td></td>
</tr>
</tbody>
</table>
9.3.5.5 Section 25: Factored Moments and Reactions

This section lists factored design moments for different load combinations. The envelope of factored moments is shown in Section 8.

Load Combination: 1.40SW + 1.70LL + 1.40SDL + 1.70XL + 1.00SEC

Factored Design Moments (Not Redistributed)

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>22.49</td>
<td>22.49</td>
<td>204.63</td>
<td>204.63</td>
<td>-418.19</td>
<td>-418.19</td>
</tr>
<tr>
<td>2</td>
<td>-412.24</td>
<td>-412.24</td>
<td>370.76</td>
<td>370.76</td>
<td>-388.36</td>
<td>-388.36</td>
</tr>
<tr>
<td>3</td>
<td>-387.38</td>
<td>-387.38</td>
<td>355.24</td>
<td>355.24</td>
<td>-29.27</td>
<td>-29.27</td>
</tr>
<tr>
<td>CR</td>
<td>-48.47</td>
<td>-48.47</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

Reactions and Column Moments

<table>
<thead>
<tr>
<th>Joint</th>
<th>Reaction Max</th>
<th>Reaction Min</th>
<th>Moment Lower Column Max</th>
<th>Moment Lower Column Min</th>
<th>Moment Upper Column Max</th>
<th>Moment Upper Column Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>69.14</td>
<td>69.14</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>250.08</td>
<td>250.08</td>
<td>1.31</td>
<td>1.31</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3</td>
<td>254.68</td>
<td>254.68</td>
<td>-0.71</td>
<td>-0.71</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>4</td>
<td>125.24</td>
<td>125.24</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Note: Moments are reported at face of support

9.3.5.6 Section 26: Factored Lateral Moments

This section list factored design moments for different load combination including lateral loads. The envelope of factored moments is shown in Section 9.

Load Combination: 1.20 SW + 1.00 LL + 1.20 SDL + 1.00 XL + 1.00 LAT

Factored Lateral Moments (Not Redistributed)

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+113.57</td>
<td>+113.57</td>
<td>+155.01</td>
<td>+155.01</td>
<td>-409.44</td>
<td>-409.44</td>
</tr>
<tr>
<td>2</td>
<td>-215.92</td>
<td>-215.92</td>
<td>+303.02</td>
<td>+303.02</td>
<td>-364.26</td>
<td>-364.26</td>
</tr>
<tr>
<td>3</td>
<td>-176.54</td>
<td>-176.54</td>
<td>+284.61</td>
<td>+284.61</td>
<td>-119.03</td>
<td>-119.03</td>
</tr>
<tr>
<td>CR</td>
<td>-37.01</td>
<td>-37.01</td>
<td>-11.30</td>
<td>-11.30</td>
<td>-0.00</td>
<td>-0.00</td>
</tr>
</tbody>
</table>

Load Combination: 1.20 SW + 1.00 LL + 1.20 SDL + 1.00 XL + 1.00 LAT

Factored Lateral Moments (Not Redistributed)

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-79.47</td>
<td>-79.47</td>
<td>+155.01</td>
<td>+155.01</td>
<td>-225.09</td>
<td>-225.09</td>
</tr>
<tr>
<td>2</td>
<td>-404.88</td>
<td>-404.88</td>
<td>+303.02</td>
<td>+303.02</td>
<td>-175.30</td>
<td>-175.30</td>
</tr>
<tr>
<td>3</td>
<td>-363.35</td>
<td>-363.35</td>
<td>+284.61</td>
<td>+284.61</td>
<td>+75.11</td>
<td>+75.11</td>
</tr>
<tr>
<td>CR</td>
<td>-37.01</td>
<td>-37.01</td>
<td>-11.30</td>
<td>-11.30</td>
<td>-0.00</td>
<td>-0.00</td>
</tr>
</tbody>
</table>

Note: Moments are reported at face of support
9.3.5.7 Section 27: Detailed Stresses

<table>
<thead>
<tr>
<th>XL</th>
<th>X</th>
<th>SW</th>
<th>DL</th>
<th>Bot</th>
<th>SDL</th>
<th>SDL Bot</th>
<th>XL</th>
<th>LL Top Max-T</th>
<th>LL Bot Max-T</th>
<th>LL Bot Max-C</th>
<th>PT Top</th>
<th>PT Bot</th>
</tr>
</thead>
<tbody>
<tr>
<td>ft</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.05</td>
<td>0.96</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>17.0</td>
<td>31.0</td>
<td>0.0</td>
<td>5.0</td>
<td>8.0</td>
<td>8.0</td>
<td>-125.0</td>
<td>-125.0</td>
</tr>
<tr>
<td>0.10</td>
<td>1.92</td>
<td>0.00</td>
<td>0.00</td>
<td>-19.0</td>
<td>-31.0</td>
<td>-15.0</td>
<td>0.0</td>
<td>-9.0</td>
<td>-16.0</td>
<td>-103.0</td>
<td>-161.0</td>
<td>-161.0</td>
</tr>
<tr>
<td>0.90</td>
<td>17.25</td>
<td>0.00</td>
<td>0.00</td>
<td>55.0</td>
<td>-91.0</td>
<td>0.0</td>
<td>0.0</td>
<td>22.0</td>
<td>22.0</td>
<td>-36.0</td>
<td>-318.0</td>
<td>193.0</td>
</tr>
<tr>
<td>0.95</td>
<td>18.21</td>
<td>0.00</td>
<td>0.00</td>
<td>73.0</td>
<td>-120.0</td>
<td>0.0</td>
<td>0.0</td>
<td>30.0</td>
<td>30.0</td>
<td>-50.0</td>
<td>-348.0</td>
<td>244.0</td>
</tr>
<tr>
<td>1.00</td>
<td>19.17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

9.3.5.8 Section 28: Required Post-tensioning

The post-tensioning required at 1/20th point along each span is calculated and listed in this table.

<table>
<thead>
<tr>
<th>XL</th>
<th>X</th>
<th>PT</th>
<th>X</th>
<th>PT</th>
<th>X</th>
<th>PT</th>
<th>X</th>
<th>PT</th>
<th>X</th>
<th>PT</th>
</tr>
</thead>
<tbody>
<tr>
<td>ft</td>
<td>k</td>
<td>ft</td>
<td>k</td>
<td>ft</td>
<td>k</td>
<td>ft</td>
<td>k</td>
<td>ft</td>
<td>k</td>
<td>ft</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SPAN 1</td>
<td>SPAN 2</td>
<td>SPAN 3</td>
<td>CR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.05</td>
<td>0.96</td>
<td>0.00</td>
<td>1.36</td>
<td>0.00</td>
<td>1.14</td>
<td>0.00</td>
<td>0.17</td>
<td>0.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.10</td>
<td>1.92</td>
<td>0.00</td>
<td>2.72</td>
<td>0.00</td>
<td>2.28</td>
<td>0.00</td>
<td>0.35</td>
<td>0.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.90</td>
<td>17.25</td>
<td>0.00</td>
<td>24.45</td>
<td>0.00</td>
<td>20.48</td>
<td>0.00</td>
<td>3.15</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.95</td>
<td>18.21</td>
<td>0.00</td>
<td>25.81</td>
<td>0.00</td>
<td>21.61</td>
<td>0.00</td>
<td>3.33</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.00</td>
<td>19.17</td>
<td>0.00</td>
<td>27.17</td>
<td>0.00</td>
<td>22.75</td>
<td>0.00</td>
<td>3.50</td>
<td>0.00</td>
</tr>
</tbody>
</table>

9.3.5.9 Section 29: Detailed Rebar

The rebar required at 1/20th point along each span is calculated and listed in this table.

<table>
<thead>
<tr>
<th>XL</th>
<th>X</th>
<th>Analysis Top</th>
<th>Analysis Bot</th>
<th>Minimum Top</th>
<th>Minimum Bot</th>
<th>Selected Top</th>
<th>Selected Bot</th>
</tr>
</thead>
<tbody>
<tr>
<td>ft</td>
<td>in2</td>
<td>in2</td>
<td>in2</td>
<td>in2</td>
<td>in2</td>
<td>in2</td>
<td>in2</td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.27</td>
<td>0.00</td>
</tr>
<tr>
<td>0.05</td>
<td>0.96</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.27</td>
<td>0.00</td>
</tr>
<tr>
<td>0.10</td>
<td>1.92</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.27</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.95</td>
<td>18.21</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.00</td>
<td>19.17</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
9.3.5.10 Section 30: Punching Shear Reinforcement

Reinforcement option: Stud
Study diameter: 0.38
Number of rails per side: 1

### Column - 2

<table>
<thead>
<tr>
<th>Layer</th>
<th>Cond.</th>
<th>a</th>
<th>d</th>
<th>b1</th>
<th>b2</th>
<th>Vu</th>
<th>Mu</th>
<th>Stress</th>
<th>Allow.</th>
<th>Ratio</th>
<th>As</th>
<th>NStuds</th>
<th>Dist.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>k-ft</td>
<td>ksi</td>
<td>ksi</td>
<td>in^2</td>
<td>in</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>17.19</td>
<td>34.38</td>
<td>35.19</td>
<td>46.37</td>
<td>-250.14</td>
<td>-1.15</td>
<td>0.082</td>
<td>0.215</td>
<td>0.38</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>17.19</td>
<td>34.38</td>
<td>295.23</td>
<td>82.37</td>
<td>-250.14</td>
<td>-1.15</td>
<td>0.025</td>
<td>0.145</td>
<td>0.17</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Dist. = Distance between shear studs between layers

Note: Columns with --- have not been checked for punching shear.
Note: Columns with *** have exceeded the maximum allowable shear stress.

**Legend (30):**
- **Layer**: The layer of the reinforcement for each column
- **Cond.**: 1 = Interior, 2 = End, 3 = Corner, 4 = Edge
- **a**: The distance between the layer and face of column or drop cap(*)
- **d**: Effective depth
- **b1**: length of section parallel to span line
- **b2**: length of section normal to span line
- **Vu**: Factored shear
- **Mu**: Factored moment
- **Stress**: Maximum stress
- **Allow**: Allowable stress
- **Ratio**: Ratio of calculated to allowable stress
- **As**: Required area of reinforcement
- **Nstud**: Number of shear studs between layers on each rail

9.3.5.11 Section 32: Unbalanced Moment Reinforcement

### 32.1 Unbalanced Moment Reinforcement - No Redistribution.
This table shows unbalanced moments for different load combinations.

<table>
<thead>
<tr>
<th>Load Combination: STRENGTH_1_Max_LL</th>
<th>Joint</th>
<th>Gamma Left</th>
<th>Gamma Right</th>
<th>Width Left</th>
<th>Width Right</th>
<th>Moment Left</th>
<th>Moment Right</th>
<th>As Top</th>
<th>As Bot</th>
<th>n Bar Top</th>
<th>n Bar Bot</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>ft</td>
<td>ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>in^2</td>
<td>in^2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.78</td>
<td>0.00</td>
<td>27.00</td>
<td>0.00</td>
<td>22.49</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>0.59</td>
<td>0.59</td>
<td>10.00</td>
<td>10.00</td>
<td>-5.94</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>0.59</td>
<td>0.59</td>
<td>10.00</td>
<td>10.00</td>
<td>-0.94</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

### 32.2 Unbalanced Moment Reinforcement – Redistributed.
This table shows unbalanced moments for different load combinations where moments were redistributed.

<table>
<thead>
<tr>
<th>Load Combination: STRENGTH_2_Max_LL_Pos_Lat</th>
<th>Joint</th>
<th>Gamma Left</th>
<th>Gamma Right</th>
<th>Width Left</th>
<th>Width Right</th>
<th>Moment Left</th>
<th>Moment Right</th>
<th>As Top</th>
<th>As Bot</th>
<th>n Bar Top</th>
<th>n Bar Bot</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>ft</td>
<td>ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>in^2</td>
<td>in^2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.78</td>
<td>0.00</td>
<td>27.00</td>
<td>0.00</td>
<td>105.65</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>0.59</td>
<td>0.59</td>
<td>10.00</td>
<td>10.00</td>
<td>-194.82</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>0.59</td>
<td>0.59</td>
<td>10.00</td>
<td>10.00</td>
<td>-186.15</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

163
9.3.5.12 Section 34: Demand Moment and Moment Capacity

This data block lists the demand moment and the moment capacity for the 1/20th points along each span based on the user selection in the Design settings input screen. Columns 7 and 8 of this table list the ratio of the demand and capacity for both positive and negative moments.

34.1 Based on User Entered Values. The capacity listed in this section is calculated with the user entered base reinforcement and PT.

<table>
<thead>
<tr>
<th>SPAN 1</th>
<th></th>
<th>Demand Moment Pos</th>
<th>Demand Moment Neg</th>
<th>Moment Capacity Pos</th>
<th>Moment Capacity Neg</th>
<th>Demand/Capacity Pos</th>
<th>Demand/Capacity Neg</th>
</tr>
</thead>
<tbody>
<tr>
<td>X/L</td>
<td>X</td>
<td>ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>113.95</td>
<td>0.00</td>
<td>296.86</td>
<td>-238.52</td>
<td>0.38</td>
<td>0.00</td>
</tr>
<tr>
<td>0.02</td>
<td>0.33</td>
<td>113.95</td>
<td>0.00</td>
<td>296.86</td>
<td>-238.52</td>
<td>0.38</td>
<td>0.00</td>
</tr>
<tr>
<td>0.05</td>
<td>0.96</td>
<td>138.03</td>
<td>0.00</td>
<td>296.86</td>
<td>-238.52</td>
<td>0.46</td>
<td>0.00</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.95</td>
<td>18.21</td>
<td>0.00</td>
<td>-365.42</td>
<td>150.07</td>
<td>-421.98</td>
<td>0.00</td>
<td>0.87</td>
</tr>
<tr>
<td>0.96</td>
<td>18.42</td>
<td>0.00</td>
<td>-388.80</td>
<td>150.07</td>
<td>-421.98</td>
<td>0.00</td>
<td>0.92</td>
</tr>
<tr>
<td>1.00</td>
<td>19.17</td>
<td>0.00</td>
<td>-388.80</td>
<td>150.07</td>
<td>-421.98</td>
<td>0.00</td>
<td>0.92</td>
</tr>
</tbody>
</table>

34.2 Based on Designed Values. The capacity listed in this section is calculated with the rebar and PT required for the design, including user defined base reinforcement.

9.3.6 Graphical Report

The graphical display includes print-plots of critical information, such as moments, deflections, stresses, post-tensioning and reinforcement.

9.3.6.1 PT Force

![Post-Tensioning Diagrams](image-url)
POST-TENSIONING REQUIRED AND PROVIDED

9.3.6.2 PT-Profile

POST-TENSIONING PROFILE

9.3.6.3 Deflection

DEFLECTION

9.3.6.4 Load Cases

LOAD CASE: Super Imposed Dead Load
Moment Diagrams (No Redistribution)
File: Mnl5-2

Shear Diagrams
File: Mnl5-2

Moment Diagrams
File: Mnl5-2

Shear Diagrams
File: Mnl5-2

Stress Diagrams
File: Mnl5-2 [(+)Tension (Limit=164.3) (-)Compression (Limit=-1800.3)]

Deflection Diagrams
File: Mnl5-2

MOMENT

SHEAR

STRESS

DEFLECTION
9.3.6.5 Load Combination

**LOAD COMBINATION: SERVICE_1.Max_LL**

**Stress Diagrams**

TWO-WAY EQUIVALENT FRAME SLAB EXAMPLE FOR A D A P T
Load Case: SERVICE

- Service 1 Max LL
- 1.00 SW + 1.00 LL
- 1.00 SDL + 1.00 XL
- 1.00 PT + 0.00 HYP + 0.00 LAT

Tensile Stress Positive

Stress [psi]

-300  -250  -200  -150  -100  -50   0  50  100

Span 1    Span 2    Span 3    Span 4

**SERVICE COMBINATION STRESSES**

(Tension stress positive)

**Moment Diagrams**

TWO-WAY EQUIVALENT FRAME SLAB EXAMPLE FOR A D A P T
Load Case: SERVICE

- Service 1 Max LL
- 1.00 SW + 1.00 LL
- 1.00 SDL + 1.00 XL
- 1.00 PT + 0.00 HYP + 0.00 LAT

Moment Drawn on Tension Side

Moment [k-ft]

-300  -200  -100   0  100  200  300  400

Span 1    Span 2    Span 3    Span 4

**DESIGN MOMENT**

(Moment is drawn on tension side)

**Rebar Diagrams**

TWO-WAY EQUIVALENT FRAME SLAB EXAMPLE FOR A D A P T
Load Case: SERVICE

- Service 1 Max LL
- 1.00 SW + 1.00 LL
- 1.00 SDL + 1.00 XL
- 1.00 PT + 0.00 HYP + 0.00 LAT

Rebar Required Top
Rebar Required Bottom
Rebar Provided Top
Rebar Provided Bottom

**REINFORCEMENT REQUIRED AND PROVIDED**

167